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Start up Photoshop and what do you see? Well,
besides the menu options along the top of the
screen, you’ll see a Toolbar that’s chock-a-block

with icons. You’ll probably recognise some of these,
such as the ‘T’ that designates the Type tool and the
paintbrush icon that unlocks the various Brush tools.
But do you really know what the rest of these icons
mean? … Honestly? The chances are that – like many
Photoshop users across the world – you’re only using a
fraction of the program’s full potential, but this second
issue in the Photoshop Focus Guide series will change
all that, helping you make the most of all the tools at
your disposal.

Even professional designers often admit to being
hopeless with the Healing Brush and dodgy with the
Dodge tool, but there’s really no reason for any of the
tools to be a mystery. This issue will help you get more
from the Clone, Gradient, Paths and Effects tools, to
name but a few. You’ll find expert tips and advice for
working more efficiently with each of the tools, as well
as tutorials to demonstrate exactly how to carry out
useful image-editing tasks. In the final section you’ll
find a step-by-step guide that brings together all the
skills you’ve learnt, showing how to create a striking
Photoshop image.

And let’s not forget the CD that
accompanies your Focus
Guide. On here you’ll
find a library of stock
images (worth £1,990),
plug-ins and video training
tutorials to enhance your
enjoyment of Photoshop
further still! 

Have fun!

Polish up your knowledge…

Unravel the mysteries of the Photoshop Toolbar and
its resident icons.They’re not as scary as they look! 
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With so much to say about
Adobe Photoshop it’s been

difficult to cram all the information
that we wanted to include into this
Focus Guide. That’s why you’ll find
the special icons that occupy the
margins so very useful.

As you leaf through the pages,
you’ll find a range of attractive
symbols, each of which denotes an
extra nugget of knowledge. The
icons enable you to identify exactly
what kind of information you’re
dealing with – for a full guide to

icon categories, see below. These
handy hints, tips and shortcuts are
always relevant to the topic that’s
being discussed, and will help you
develop your Photoshop skills that
little bit faster.

Our writers are always experienced
Photoshop experts who regularly
contribute to our sister magazines,
such as Computer Arts and Digital
Camera Magazine. So you can rest
assured that all the information 
they provide is both authoritative
and thoroughly tried-and-tested. 

Finding your way

Read this Guide from beginning to end or dip in and out 
as you please. Either way, our icons will prove indispensable…
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Icons explained

On your CD-ROM
Some of the software that we refer to may be
included on your bonus CD. Every now and then 
we remind you of this by flagging up the disc icon
and listing what’s on it. Handy, eh?

Top tips
This indicates an expert tip. Anything sheltered
beneath this icon is guaranteed to reveal a useful
hint about using Photoshop’s extensive range of
tools, palettes and features.

Further information
We’d like to tell you absolutely everything, but
there’s just not enough space. Instead we refer 
you to other useful resources, such as websites 
and specialist books for further reading.

Shortcuts
Carrying out common tasks again and again can
get a little tedious. Our handy shortcuts show you
how to carry out these tasks with a few deft 
key-presses, saving you lots of time and effort.

Take note
You’ll find a number of these nuggets of knowledge
scattered throughout the Guide.They’re crammed
with useful information that complements the
main text perfectly.

Watch out!
The skull and crossbones sign means proceed 
with caution.You’ll find some important points
outlined below this icon, which you should 
certainly take seriously.

Links
When we refer to a website, we may pull out the
web address in the sidebar to make it easier for 
you to read and remember.
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Chapter 1

SELECTION
TOOLS IN
PHOTOSHOP

In earlier versions of Photoshop
there was no Select tool – one

that looked like a traditional arrow
cursor, that you would use to select
‘objects’. Because Photoshop dealt
primarily with pixels, it made no
sense to have a Select tool – there
were no ‘objects’ to select. Instead,
the selection tools were default tools
– ones you used automatically, to
begin editing.

In Photoshop 7.0 there is an arrow
tool for selecting objects, since the
introduction of vector shapes (those
drawn using a series of points or
‘vectors’) made this necessary.
Despite this, the selection tools, in
their many and varied forms, are still

In this chapter…

D i s c o v e r  h o w  t h e
P h o t o s h o p  s e l e c t i o n
t o o l s  w o r k

L e a r n  h o w  t o  m a ke
a c c u r a t e  s e l e c t i o n s

C r e a t e  p a r t i a l  o r
g r a d i e n t  s e l e c t i o n s

Making selections is the core of Photoshop’s
way of working.There are a variety of tools you
can use for the purpose, so let’s take a look at
how to get the most out of them

the main tools for doing 90% of the
tasks in Photoshop.

Selections are an essential part of
understanding Photoshop’s methods
and central to the way the program
works – making a selection then
performing an action on that
selection is the basic workflow. 
The better you become at Photoshop
the better you’ll become at making
selections and vice-versa.

No need for discretion
What’s important to understand,
though, is that selections are not
necessarily discreet. They don’t have
to define rigidly what is or is not
selected – they can be partial too. 



It is perfectly possible to make
selections so that some pixels are
100% selected and others are 100%
unselected, and in between there is a
selection gradient, where pixels are
partially selected. This is how you
create effects that blend smoothly
into existing pixels, and this also
forms the basis of ‘anti-aliasing’ –
smoothing jagged, pixelated edges.

Feathering is the most basic
implementation of gradient
selections in Photoshop. When
making a rigid selection using one
of the Marquee tools for instance,
you can tell Photoshop to make the
edge of the selection slightly soft, or
‘feathered’. This effectively creates 

a border around the selection where
some of the pixels are partially
selected, smoothing whatever effect
or operation is applied to the
selection, or merely preventing
jagged edges.

The soft option
By making the feathered edge larger,
you’ll be able to create very soft
selections, and this is very useful when
making photo-montages, for instance,
or retouching images. We’ll look at
how anti-aliasing and feathering are
implemented in Photoshop’s selection
tools, and how you can use them to
achieve professional results quickly
and easily.
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Selections

Page 17 The Magic Wand tool selects an
object in an image to change the colour

Page 20 Photoshop can convert
channels into selections and vice-versa

Page 18 Quick mask mode turns any
painting tool into a selection tool

Page 12 The Circular Marquee tool
makes an elliptical selection

Page 13 Single Column marquees are
used to select only certain columns 

Page 15 The Magnetic Lasso lets you
make detailed selections with ease



Basic Selection tools

Let’s take a look at the various tools in the
toolbar available for making selections
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Changing
marquees
Holding down the
[Alt] key will change
the marquee mode so
that the selection
expands from the
centre, rather than the
corners, as you drag.

Shifting around
Rather than using the
buttons you can hold
down modifier keys to
add and subtract
selections.To add, hold
the [Shift] key before
you begin to click and
drag.To subtract hold
the [Alt] key before you
click and drag.The
marquee cursor will
change to show which
mode you are in.

In Subtract mode, you can remove areas
from the current selection. Here we

changed to the Circle Marquee tool to
subtract an elliptical shape from the
rectangular selection we had made.You can
continue to make negative selections that
chip away at the current selection.This is a
good way to refine a selection to fit a specific
shape in an image.

4

The Options bar displays tool-specific
settings.The selection tools all have a set

of four buttons that change the effect that
subsequent selections have on the one that’s
currently active.The normal mode is New
Selection – each time you click and drag, a new
selection is made and the current one is lost.
Add mode makes the current selection larger
and a different shape.

3

The Circular Marquee works in exactly
the same way, except the selection will

be elliptical. With both tools you can constrain
the selection so it is either a perfect circle or a
perfect square by holding down the [Shift] key
while you drag. Lift your finger off the [Shift]
key while still holding the mouse button
down to switch back to unconstrained mode.

2

The Rectangular Marquee tool is the
first tool in the Toolbar, and is used to

select rectangular areas of an image. It’s
simple to use – just select the tool and drag
across the image to select the area you want.
By default the tools works in corner-to-corner
mode. Dragging from top-left or bottom-right
creates the marquee.

1
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Short intersection
To activate Intersect
mode without using

the buttons hold
down the [Alt} and

[Shift] keys before you
drag.

Perfect circle
If, after dragging while

holding down the [Shift]
key, you want to force

the selection to be
constrained to a perfect

circle or rectangle,
release the [Shift] key

momentarily and press
it again. Holding the

[Alt] key while dragging
will force a selection to

be drawn from its centre
as mentioned.

If already holding the
[Alt] key, such as when
using the Intersection

shortcut, momentarily
release it and then 
press the [Alt] key.

This forces the
‘constraint from 
centre’ to occur.

Uses for the Single Row and Column
Marquees are varied, but not always

obvious. Here, they’re used to create multiple
random vertical and/or horizontal lines in an
image much more quickly than using the
Pencil or Line tool.The Add Selection mode
was used and the selections filled with black,
on separate layers, to create lines whose
opacity and blending mode we can vary.

8

The last two selection types in this tool
group are the Single Row and Single

Column Marquees.These are special types of
marquee which, as their name suggests, select
either a single row or column of pixels. In this
case dragging only defines which row or
column in the image is selected and the
selection extends to the edges of the image 
in either mode.

7

This is the result of the intersection.
Note that it’s only the overlapping parts

of the two selections that remain selected.
This selection method is not used very often
but you’ll appreciate just how handy it can be
in certain situations. Creating similar
selections any other way would be very
difficult and time-consuming.

6

The fourth mode is Intersect. When in
this mode, you can create a new

selection that is the intersection between the
currently active one and one you will drag out.
Basically all parts of the current selection will
disappear except that portion that overlaps
with the new selection you drag out. Here is
the original selection with a new one being
dragged out over it, using the Intersect mode.

5



The Lasso tool is a free-form
selection tool. You can use it

like a pen to draw your selection
border by hand. When using the
Lasso tool selections can be any
shape you like, but it can be hard to
be precise because selection must be
drawn in a single motion. The
Polygonal Lasso is much easier to
use, and can be found in the Lasso
tool pop-up in the toolbar. This
enables you to click from one point 
to another to create straight line
segments to make up your selection.
All you need to do is double-click,

or click on the starting point of the
selection to end it and consequently
close your selection.

The Lasso Tools

The standard, Polygonal and Magnetic Lassos
are ideal for creating complex selections 
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Using the [Alt] key technique allows you the best
of both worlds, drawing straight sections or
detailed curves as and when you need to

Poly-gone
When using the
Polygonal Lasso
holding down the 
[Alt] key invokes the
normal Lasso tool.
Releasing the [Alt] key
reverts back to the
Polygonal Lasso.

Combined Lasso
With the Lasso tool
active, just hold down
the [Alt] key at any
stage to turn it into the
Polygonal Lasso.

THERE ARE two ways in which to work using the [Alt] shortcut.

Assuming you have the normal Lasso tool selected, if you keep the [Alt]

key held down when you click and drag, the tool will behave like the

normal Lasso.

IF YOU want to get really precise, then the Magnetic Lasso is the key.

With this selection tool you can draw close to the edge of the object you

wish to select and the tool will figure out where the boundary should be

and adjust the selection to fit.

YOU CAN set the Frequency high to place lots of points as you drag.

This can be handy for jagged edges.

A LOW Frequency is also useful when you don’t need the added

complexity of hundreds of anchor points, but can make do with a 

less precise selection.

LASSO OPTIONS ROUNDED UP



The Magnetic Lasso

If you want detailed selections without too
much effort, here’s the perfect tool for the task
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Fast pan and zoom
You can use the Pan and
Zoom shortcuts to move
the image around while
still in mid-selection. See

Chapter 2 for more
about navigating and

editing your images.

Magnetic switch
Hold the [Alt] key to

activate the
Polygonal Lasso 

tool when using the
Magnetic Lasso.

Another trick to help on very low
contrast portions of an image, such as

where the pumpkin stalk is in front of the girl’s
face again, it can help to increase the
Frequency setting.This will cause the tool to
place anchor points more often, therefore
reducing the span of pixels it has to analyze as
you drag the mouse.

4

This is a problem of contrast. By
reducing the Edge Contrast setting in

the Option bar you can help the Magnetic
Lasso to detect edges that are lower in
contrast. But you will still need to manually
add anchor points by clicking, to help the
Lasso do this.

3

If the area you are tracing is too
indistinct and low in contrast for

Photoshop to find an edge itself, you can click
the mouse to force an anchor point to be
placed.The default setting in the Options bar
is fine most of the time, but there can be
problems – here, the tool has no problem with
the edge of the hair, but it didn’t seem to
detect the pumpkin stalk.

2

This tool lets you make more detailed
selections, particularly of specific

objects in an image, without requiring too
much effort.You don’t have to keep the mouse
button held down when drawing either – 
click once to start, drag close to the object
edge, then double-click to end. Note that the
tool automatically places ‘anchor points’ as
you draw to keep the selection in place.

1



The Magic Wand

The Magic Wand is a special selection tool,
used for selecting areas of similar colour
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Unrestricted
colours
When the Contiguous
setting in the Options
bar is checked,
Photoshop makes a
selection of similar-
coloured pixels that
are also physically
joined to your starting
point. Disable this
setting and similar
colour pixels across
the whole image will
be included, which
can take a few
moments.

Use All Layers
The Use All Layers
option allows you to
calculate the selection
based on how the
image actually
appears on screen
when working with
multi-layered
documents. If this is
left unchecked, then
only colours on the
currently selected
layer will be analysed
for similarity.

We can improve the ability of the wand
to select the colours we want by

increasing the Tolerance setting, from the
default 32, to 50 then [Shift]+clicking in each 
of the separate areas. Any other parts of the
jumper still not selected can be added by
[Shift]+clicking on them again until you have
a good clean selection with no ‘islands’.

4

The Magic Wand will only select colours
within a certain range, defined by the

Tolerance setting. And it will only look at
contiguous pixels – that is, ones that actually
touch each other. Areas of colour not directly
connected, like the chest and other arm, are
not considered for selection.

3

Most images don’t contain large areas of
flat colour like the one above, so here’s a

more typical use for the Magic Wand – selecting
the girl’s jumper to change its colour. Using the
Magic Wand, we can click on a section of the
jumper to select all pixels with a similar colour.
However, using the default setting there are
many ‘islands’of unselected pixels, so not all of
the jumper has been selected.

2

The Magic Wand tool is used to select
areas using a single click.The tool works

by sampling the colour of the image where
you click and then looking at all adjacent
pixels for those that are the same or similar in
colour.Take a well-defined shape like the one
here and click in it with the Magic Wand – the
whole shape is selected in one go.

1
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Colour tweaks
The Hue/Saturation

panel lets you adjust
the whole spectrum
or individual sectors

of the colour
spectrum. Choose

these from the 
pop-up menu.

Let it slide
The sliders at the

bottom of the
Hue/Saturation panel

enable you to adjust
the range of colours

affected in 
each sector.

By selecting the layer mask and
applying the Gaussian Blur filter with a

smallish value we can make the layer mask
slightly bigger.Then by applying Levels to the
layer mask we can make the blurred edges
brighter, controlling how much of the
Hue/Saturation effect is applied to this area.

8

If we zoom into the document we can
see that there is a slight fringe of red.

This is because some of the jumper that
overlaps the background was left unselected.
This is a limitation of the tolerance setting
used by the Magic Wand. Fortunately, there is
a way we can fix this.

7

By adding a Hue/Saturation Adjustment
Layer while the selection is still active,

you can change the colour of the the jumper,
and only the jumper. Photoshop creates a
layer mask from the selection and uses is to
limit which areas of the adjustment layer will
actively affect the layers below.

6

Here you can see that a part of the arm
has been selected.This is due to the

high tolerance setting used.You can easily
remove it from the selection, but first reduce
the tolerance to a lower value, such as 24,
then [Alt]-click on the arm inside the selection
to remove it.

5



Quick Mask

Quick Mask is not a tool as such, but a mode
you can enter when working with selections
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Fill the gaps
Holes in a Mask or
Quick Mask can be
filled by selecting the
inside or outside area
and applying the
Minimum filter.

Keep it sharp
Apply the Minimum
filter to a copy of a
layer using the
Overlay mode to 
give you a ‘live’
sharpening layer.

While in Quick Mask mode, therefore,
you can use any of the normal painting

tools to modify your mask, and hence your
selection.You can see that Photoshop offers a
huge amount of freedom when creating
selections, and this is indicative of how
important selections are when using
Photoshop. Here, the Paintbrush tool is being
used to clean up the mask.

4

The red overlay is slightly transparent
so you can see what it beneath. Red

areas are masked out (unselected) while 
clear areas are unmasked (selected). But
internally, Photoshop stores the mask in
shades of grey, not red – so this is how the
mask looks to Photoshop.

3

By clicking the Quick Mask button at
the bottom of the toolbar, or pressing

the [Q] key, the selection is converted to a
mask.The mask is displayed, not in shades of
grey, but as a semi-transparent overlay.This
mimics the techniques used in traditional
printing where a red ‘rubylith’ overlay is used
to mask out parts of a photo or artwork.

2

When any selection is active, no matter
which of the selection tools you started

off using, you can enable Photoshop’s Quick
Mask mode. Here is a less-than-perfect
selection we have made using the Magic Wand.

1



When painting, take notice of
the foreground colour

indicated in the bottom of the
toolbar. When in Quick Mask mode
this will only indicate shades of
grey, so any colours you have set
will appear grey. Hitting the [D] key
sets the colours to the default, white
and black. As you paint you can use
the [X] key to reverse the background
and foreground colours so that you
can paint in white (unmask) or black
(mask) to edit the mask.

Once you have touched up the
mask, you can press the [Q] key

once more to exit Quick Mask
mode. You’ll then be able to convert
the edited mask to a selection. 

Working with the Quick Mask

The Quick Mask lets you create a ready-made
mask,which you can edit or turn into a selection
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Make use of the foreground and background
switch key [X] to flip between masked and
unmasked colours

Disappearing ants
To hide the ‘marching
ants’ while a selection

is active use the
[Crtl]+[H] shortcut

(that’s
[Command]+[H] 

for Mac users). Be
careful to remember

that you have a
selection active

though!

Hiding
applications

To hide other
applications on a Mac

and leave only
Photoshop visible, type
[Command]+[Alt]+[H].
On PCs, Photoshop has

an application
background window,

so this is not
applicable.

IF YOU need to make a selection slightly bigger all the way round, you

can do so using the Select > Modify > Expand menu command. A dialog

will appear in which you can enter the number of pixels by which you

wish to expand the selection.

YOU CAN contract a selection by using the Select > Modify > Contract

menu command.To make a selection larger by a specified number of

pixels around it, choose Select > Modify > Expand from the menu.

TO SOFTEN a selection and make its border less jagged, you can use

the Select > Feather menu command, enter a value in pixels (from 1 to

250) and click OK.

IF YOU need to modify just the border of the selection area you can

select it using the Select > Modify > Border.This is useful for creating

special edge effects, in combination with some filters, like Torn Edges.

HOW TO MODIFY YOUR SELECTIONS



Selections,Masks and Channels

Let’s look at selections in a little more detail to
see how how they relate to layers and channels
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Alpha channels
The term alpha
channel simply means
any extra greyscale
channel saved along
with the three RGB
channels, or four CMYK
channels, that make up
a colour image file.
Photoshop files can
store many of these
alpha channels at once.

Channel selection
[Ctrl]+[Alt]+[Shift]+click
on a channel to load
the intersection of the
current selection 
and a channel.

To reload a channel as a selection once
again,click the Load Channel As Selection

button at the bottom-left of the Channels palette.
A better technique is to press [Ctrl] (or
[Command] on a Mac) while clicking on the
channel icon directly – we can load the larger
ellipse as a selection (by pressing [Ctrl/Command]
while clicking on it) then subtract the smaller
ellipse by pressing [Ctrl/Command]+[Alt] while
clicking its icon in the Channel palette.

4

Now that the selection is saved as a
channel, we can drop the selection and

continue to make new ones. It’s only possible
to have one selection active at a time, so
saving them to a channel is a convenient way
to store them for use later on. Here we’ve
created another selection and saved it as
another channel. It’s just a larger ellipse.

3

We can convert the selection into an
‘alpha’ channel by switching to the

Channels tab and clicking the Save Selection
As Channel button, (second from the left at
the bottom of the palette).The selection is
then represented by a greyscale image.

2

As we’ve seen with the Quick Mask
mode, selections are handled internally

by Photoshop as a greyscale image or ‘mask’.
White areas in the mask are pixels that are
fully selected, black areas are fully unselected
and grey areas are partially selected. Let’s
create a simple selection using the Elliptical
Marquee tool.

1



Slices

Slices are special kinds of selections for web
page design, before the Image Ready stage
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Reassembled slices
When you save the

sliced page Photoshop
creates an HTML file

plus separate image files
for each slice. When the

HTML file is read by a
web browser all the

slices are reassembled in
their original position,
giving the appearance

of a single image 
once again.

Keep it tidy
Hold the [Ctrl] key

while using the Slice
tool to toggle the Slice
Select tool on and off.

Use this to select a
slice and drag its edge
handles to resize it. Be

careful not to have
any unnecessary

‘sliver’ slices between
the main slices. Zoom

in to check they all
butt up against each

other nicely.

Now choose File > Save For Web to open
Photoshop’s web compression tool. In

this panel, you can select each slice and apply
precisely the compression most suitable. For
example, a photo saved as high quality JPEG,
the text as a medium quality JPEG and the
graphics as GIFs.The backgrounds can be saved
as low quality JPEGs.This sliced, higher quality
image is only 5k larger than our first attempt.

4

Using the Slice tool we can divide up
the image into sections. It’s simple to

use – just select the tool and drag out
marquees to cut the image into appropriate
boxes. Photoshop automatically adds extra
slices where necessary to keep everything
rectangular because each slice essentially
becomes a separate image file.

3

The problem here is that the different
kinds of graphics element on the page

really need to be saved individually using the
compression settings best suited to each.
We can’t do this without using slices in
Photoshop. As this pretty extreme example
shows, achieving a small file size causes most
of the elements to look terrible.

2

Here’s an example of where slicing can
really help.This is an example web page,

containing text, a background, a photographic
image and graphics created in Photoshop.
Obviously, for the web we want the page to
download as fast as possible but also look as
good a possible.

1



Chapter 2

NAVIGATING
AND EDITING
YOUR IMAGES

Being able to zoom and pan an
image is important when

working on a Photoshop document.
Like all other aspects of the program
there is more than one way to get
around an image, manage your
windows and documents, and
generally navigate the Photoshop
landscape. Similarly you’ll need to
be able to work with the elements
within a document, such as masks,
layers, floating selections, paths and
vector masks. There are a number of
tools to accomplish these tasks.

As mentioned before, Photoshop is
not an object-based 2D program –
that is, you work directly with the
pixels of a layer until you explicitly

In this chapter…

L e a r n  h o w  t o  p a n  a n d
z o o m  i m a g e s

D i s c o v e r  h o w  t o  s e l e c t
a n d  m o v e  l a y e r
e l e m e n t s

U s e  s h o r t c u t s  t o  s c a l e
a n d  p a n  t h e  v i e w

Wo r k  m o r e  e f f i c i e n t l y
a n d  p r o d u c t i v e l y

Getting around inside an image is important if
you are to work quickly and efficiently.This
chapter covers the view navigation tools and
shortcuts for managing your workspace

do something to change that fact,
such as creating a new layer on
which to paint. In some 2D
programs, every time you paint a
stroke or apply an effect, a new
object is created. While this gives
you a totally non-destructive way of
image editing, it can make managing
your document a very complicated
procedure. In Photoshop it’s much
more straightforward.

Painting in layers
If you paint on an image layer, stop
say, to change colour, then paint over
what you just did, the result
destructively alters those pixels in
the layer. It’s much like painting in



the real world, except in Photoshop
you have an Undo command.

If you need to paint over the top of
existing artwork and be able to go
back and change the position, size,
colour and opacity of those strokes
later on, then you have to paint on a
new layer. This holds true for any
other aspect of the program where
new pixels are created.

While the Selection tools – the
Marquee, Lasso and so on – are used
to select pixels within a layer, there
are other tools for selecting and
moving layer elements themselves.
These include the Move tool, the
Path Select tool and the Direct
Selection tool for dealing with

vector-based elements. It’s important
to learn the difference between
them, and we’ll examine these
differences more closely in the
following pages.

Old and new
The Path Select and Direct Selection
tools are not easy to find in older
versions of Photoshop. The Path
Select tool used to be part of the Pen
tool group, but can now be found in
its own tool group on the toolbar.
Many revisions have been made to
both the menus and toolbar, but 
rest assured that most of the
information in this book also applies
to older versions of Photoshop.
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Page 24 Use the Zoom and Pan tools 
to navigate your images on screen

Page 25 The Navigation palette is great
for giving an overview of the whole page 

Page 26 Manage your screen space
when multiple documents are open

Page 31 Use the Direct Selection and
Path tools to work with paths and vectors

Page 29 Quick 3D effects are possible
using the Move tool in copy mode

Page 28 The Move tool enables you to
navigate your layers with a pop-up menu



Panning and Zooming images

Here we show you the basic navigation tools
available for viewing your image
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100% accuracy
To zoom the image so
that it is at exactly
100% scale, double-
click the Zoom tool 
in the toolbar.

Viewing options
Use the buttons in the
Option bar to zoom
the image to full size,
print size or to make 
it fit on screen.

Two useful options are the Resize
Window To Fit and Ignore Palettes

options in the Zoom tool’s Option bar. With
the former option enabled the window will
change size along with the image, and with
the latter option enabled the window will
continue to extend below any open palettes,
though not the toolbar.

4

To zoom out again, either click the
Zoom Out button in the Option bar and

click in the image, or hold down [Ctrl] and click
(that’s [Option]+click on a Mac). If the image
extends past the borders of the window you
can pan the image by clicking on the Pan tool,
or holding the Space Bar at any time and
dragging in the window.

3

At the bottom of the toolbar are the
Hand (which we’ll refer to as the Pan

tool) and Zoom tools. Click the Zoom tool
then click on your image to zoom in.
Eventually you’ll zoom in so far that the
individual pixels will become visible as large
blocks of a single colour.You’ve exceeded the
resolution limit for the image on your monitor,
but getting this close is often very useful.

2

When you open an image in Photoshop
it is automatically scaled so that the

whole image is visible at once.The scaling
factor is displayed as a percentage in the
window’s title bar. But how do you zoom in to
see more detail in a large image? As is often
the case when using Photoshop, there are a
number of different options.

1



The Navigator panel

A useful device for getting around documents
is the Navigator panel. Here’s how it works
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Navigator panel 
This can be very

useful when working
on multiple monitor

set-ups.You can have
a full-screen preview

of your image on one
monitor while you

work up close on
another.This prevents

you continually
zooming in and out to

see how the editing
looks relative to the

rest of the image.

A different scale
Some previous

versions of Photoshop
do not allow

incremental and
fractional scaling –

you can only scale out
to 75%, 50%, 25%,

12.5%… or in to
125%, 150%, 200%

and so on.

The triangle at the top-right of the
Navigator accesses the options for the

panel.There are only two in Photoshop 7:
Dock To Palette Well and Options.The latter
lets you change the colour of the zoom box,
which can be handy if you have a very red
image like ours and the box is hard to see, of if
you just don’t like working with the red colour.

4

To zoom in and out using the Navigator
you have a few different options.You

can use the zoom slider to interactively zoom
the image, and that’s quite fun to do. Or you
can click on the Zoom In and Zoom Out
buttons either side of the slider. Or you can
click in the text field to enter an exact scale.

3

The Navigator panel is very useful when
zoomed in very close to an image,

because it shows you with a red box exactly
where in the main image the zoomed in
portion is located. Note that you can make the
preview larger by dragging the lower right
corner of the palette to resize it, even to fill the
whole screen.

2

From the Windows menu you can access
the Navigator panel, though it’s open by

default in Photoshop.This is a handy tool
because it enables you to view the entire
image in a small window, pan the main view,
and zoom in and out, all from the same small
area on screen. It’s great for those that don’t
like to use keyboard shortcuts.

1



The main interface in Photoshop
is quite simple and well laid-

out, but it has been constantly
refined through development to
offer highly efficient document and
view management. Within the main
menu is the View menu which has
many view management options –
the Zoom In and Out commands and
their respective shortcuts, as well as
commands to show the Rulers,
Guides and Grids and the option to
enable various kinds of snapping. 
As well as using the Navigator or
Zoom tool you can use the shortcuts

[Ctrl]+[+] and [Ctrl]+[–] to zoom in
and out (Mac users replace [Ctrl]
with [Command]). 

View management

Photoshop has several gadgets to help you
work with various views of your document
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Multiple documents can be arranged on the
screen using Tile, in Windows > Documents. This
fits your images next to each other on screen

Floating away
The floating palettes
can get in that way,
especially if you are
working on a small
monitor. No matter, at
any time you can hit
the [F] key to toggle
the display mode to
full screen. Use the
Tab key to toggle the
palettes on and off to
get a totally
uncluttered view.

When the Zoom tool is
active the Options bar
displays a few extra buttons –
Actual Pixels, Fit On Screens
and Print Size. These zoom
the view to specific sizes.

The Navigator panel is
grouped with the Info
palette. Use the navigator to
perform multiple view
navigation tasks in one area,
with one hand. You also get a
handy image preview.

The Print Size pop-up is
located at the bottom of the
document window. Click on
the blank space here to
preview how large the image
will print out on the paper
size set in the Print dialog.

Yet another way to zoom
the document is to type in a
value here at the bottom-left
of the document window.

The Zoom and Pan tools
can be found at the bottom
of the toolbar. Click on these
to zoom and pan inside 
the image.

At the bottom of the toolbar
are buttons to control full
screen view. The middle one
makes the current window fill
the screen, the right makes
the menu bar disappear and
the left returns it to normal.

ZOOMING AROUND



As well as moving and copying
pixels, Photoshop’s Move tool

allows you to align and distribute
objects evenly across the document
or within a selection. With the Move
tool selected you will see a number
of options available. 

The first option, Auto Select
Layer, is very handy. It enables you
to click on a pixel in the image to
select that layer. The next, Show
Bounding Box, displays a transform
box around the selection or element
or layer. You can drag the handles on
the edge of the box to move the

selection. If you click on the lines,
you’ll switch to the Free Transform
mode, enabling you to scale, rotate
and deform the objects.

The next section of options only
becomes active when you have
linked layers. To link layers so that
you can move them as one object, go
to the Layers palette and click the
blank icon box between the eye icon
and one of your layers. A chain icon
now appears in the blank icon box,
indicating that the layer you have
just clicked next to is now linked to
the currently selected layer.

Move,Align and Distribute

The latest version of Photoshop has handy
Align and Distribute features
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Line them up 
The Align features

work with selections
on fully filled layers
too. If a selection is

active then it is used
as a master guide for

all the layers to be
aligned to. If you have

accidentally moved
image layers so that
they lie partially off
the canvas you can

use the Align feature
to make them all line
up again squarely on

the canvas.

When you select a layer that has other layers linked to it the

Align and Distribute options of the Move tool become

active. Click on these to distribute the layers or align them to

various key points.You can use the Align Left Edges button,

for example, to align individual text layers so that their left

edges line up. It’s important to note that these options only

take into account the bounding box of the layer. If you have

a series of layers linked together but they are filled totally

with pixels, then the align options will have no effect. This is

because the layers have nowhere to be aligned to, as they

are already lined up on the canvas.

ACTIVATING ALIGN AND DISTRIBUTE

Feel like going MAD? Here’s how to Move, Align and Distribute

The Align and Distribute buttons in
the Move options bar can be used to
align multiple linked layers 



The Move tool

The Move tool is a very handy, multi-purpose
gadget – and surprisingly easy to use
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On the Move
At any time,no matter
what tool is selected,
you can  access the
Move tool by pressing
[V] on your keyboard.

Scissor action
The Move tool cursor
displays a pair of
scissors next to it
when it is over an
active selection.

If a selection is active then the Move
tool will move the pixels in the selection

only, as opposed to the whole layer. Here
we’ve selected the whole object in a flattened
document and dragged it.The result is that
the pixels are lifted and moved, leaving a 
hole behind.

4

You can scroll your mouse through the
list to select precisely the right layer you

want to move without having to go to the
Layers palette. Here we’ve selected the
Wireframe layer, and moved it. Getting into
the habit of naming your layers will help here.

3

The neat thing about the Move tool is
that it has a built-in layer navigation

feature. In a multi-layer document you can
find out exactly which layers are beneath any
given point in an image by control-clicking
and holding on the image. A menu will pop up
displaying the names of the layers in order,
from the top downwards.

2

The Move tool is the second tool at the
top of the toolbar. It looks like an arrow

but without the tail. Use this tool when you
want to move elements in a document, be
they selected pixels or whole layers.

1
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Extrude and move
In the 3D text example

on the left, we first
created a text layer,

then loaded it as a
selection by command

clicking the layer. In a
new layer below the

text layer we created a
gradient through the
selection, and with it
still active we carried

out an extrude-
move function.

Computer Arts 
To discover even more

ways to develop your
Photoshop skills,

check out our sister
magazine,

Computer Arts.
You can find the 

magazine’s website at
www.computerarts.co.uk.

A nifty trick is to hold down the [Alt] key
and use the arrow keys to nudge the

selection diagonally. Used on a text outline
filled with a gradient like this, repeatedly
pressing the Up and Right Arrow keys creates
an extruded 3D object.

8

Another way to do this is to create a
new layer from the selection first, then

use the Move tool as normal. With a selection
active press [Ctrl] + [J] (that’s [Command] + [J]
on a Mac) to convert the selection to a new
layer, then move it as normal.

7

Now as you drag the selection will be
copied, lifted and moved to another

location on the layer. Note that while the
selection is still active the copied pixels
occupy a quasi-layer.This is said to be
‘floating’ selection.You can move it around 
as if it was on its own layer. Only when you
deselect the pixels will it be dropped on to 
the layer.

6

Moving pixels and leaving a hole behind
may be fine in some circumstances but if

you want to copy the pixels instead of cutting
them out then you have to hold down the [Alt]
key (often called the ‘Option’ key on a Mac,
although it’s still labelled ‘Alt’) as you drag with
the Move tool. Notice that the cursor will
change to a double arrow, indicating you’re
now in Copy mode.

5

http://www.computerarts.co.uk


Direct and Path Selection tools

Use the Path Selection and Direct Selection
tools to move and edit paths and vector shapes 
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A familiar Path
The Path Selection
tool is much like the
old arrow cursor in
the Pen tool group of
previous versions of
Photoshop, before 
vector shapes 
and masks 
were introduced.

Hide and seek 
You can show and
hide the path outlines
by typing 
[Ctrl]+[Shift]+[H], on
your keyboard (that’s
[Command]
+[Shift]+[H] for Mac
users) or toggling the
Views > Show >
Target Paths menu
command on and off.

With both paths selected you can click
on the Combine button in the Path

Selection’s Option bar to merge both (or as
many as you like) into a single path. If you click
away from the paths to deselect them, then
reselect them, you’ll see that all the paths are
now selected because they are one.

4

Much like other selections in Photoshop
you can add to them using the [Shift]

key. Here we have selected both paths by
[Shift]-clicking on the second path to activate
it. Both can now be transformed together.
However, to make this work you must have
the Show Bounding Box option turned off.

3

For this we need to activate the Path
Selection tool.This is in the eighth row

of the toolbar and looks like a black arrow
cursor. With this selected, clicking on the
edges of each path in the vector mask selects
it. We are able to move the path and transform
it to fit by making the bounding box visible
and clicking on the edge of the box to activate
Free Transform.

2

Here we have two vector shapes in a
single vector mask applied to a Solid

Colour layer.They are not properly aligned
and we need to select them independently,
but how? The Move tool only lets us move
the whole layer, so we’re not able to select 
the paths independently.

1



Vector shapes and multiple paths

Follow our step-by-step guide to working 
on vector shapes and multiple paths 
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Take the A road 
The [A] key is the

shortcut to the Path
Selection tool group.

To toggle between
Path and Direct

Selection mode type
[Shift]+[A].

Make a point
Clicking once on a

point that already has
handles with the Cusp
cursor converts it to a

sharp point with 
no handles.

With the Direct Selection tool you can
select a point in order to access its

Bezier handles and modify the shape of the
curve. If a point has no handles you can pull
them out by holding down [Ctrl]+[Alt] as you
drag ([Command]+[Alt] on a Mac).The tool
changes to an inverted ‘V’, called the Cusp tool.

4

With either the Direct Selection or Path
Selection tools active you can duplicate

a path, or multiple paths by [Option]+dragging
them.The cursor will change to display a plus
sign next to it when you hold the Option key
down as a visual cue that you are about to
make a copy.

3

If you need to select multiple points on
a path and move them as one you can

drag out a marquee with the Direct Selection
tool. Alternatively the usual ‘shift to add’
maxim holds true: [Shift]+click to add points
to the selection that are difficult to select
within a single marquee.

2

If you want to edit the points of a vector
shape mask then you need to change

from the Path Selection to the Direct Selection
tool.With this tool active, you are able to 
click to select individual points in a path or
vector shape.

1



Chapter 3

USING THE
BRUSHES AND
PENCIL TOOLS 

Photoshop is traditionally known
for image manipulation,

retouching, effects and colour
correction, but not so much as a
painter’s tool. This has partly been
due to the fact that the artistic
capabilities of the program were
severely limited due to the poor
support for artistic media
simulation. Other programs such as
Corel Painter used to lead the market
here, but the last few versions of
Photoshop has seen it’s Brushes
system completely overhauled,
making it much more useful as an
artistic media program.

Having said that, Brushes have
always been essential for just about

In this chapter…

U s i n g  t h e  B r u s h  a n d
P e n c i l  t o o l s

E d i t i n g  a n d  s a v i n g
b r u s h  p r o p e r t i e s

C r e a t i n g  c u s t o m  
b r u s h  t i p s

U s i n g  t h e  H i s t o r y  a n d
A r t  H i s t o r y  b r u s h

This chapter introduces you to Photoshop’s
more arty tools, the Brushes. However, as we’ll
see, you can use these versatile tools for far
more than just painting

everything else in Photoshop, and
getting the most out of the Brush
tools involves finding out all the
little secrets and features buried
inside the program. Actually they’re
not that secret but its surprising how
few of the shortcuts some Photoshop
users know. It’s usually those who
have been using it since the early
days that know all the best tips. 

Spoilt for choice
In a way, the later, feature-rich
versions spoil you by giving you so
many options to work with. The
History palette, introduced in
version 5, is a fantastic time-saving
device. It’s also an incredible feature



that takes the basic Photoshop
functions and multiplies their
capabilities tenfold. The History
palette essentially adds a kind of
non-linear undo to the program.
Previously undo was limited to just
hopping back step-by-step. The
History palette displays all your
operations (up to a maximum
number that you specify) in a list,
complete with the tool used and its
icon. By clicking on any of these
steps you can immediately jump
straight back to the document as it
was at that point in time.

Even more impressive is the
ability to store permanent snapshots
of the state of the document at any

time. These will not ‘fall off the
back’ like items in the undo list
would when the list exceeded the
number of steps set in the
Preferences. However all this power
and flexibility comes at a cost: 
disk space. The History states can
consume very large amounts of
‘scratch disk’ space, the random
storage bin that Photoshop uses as a
kind of virtual memory.

Performance figures
Keep a large amount of hard disk
space free for Photoshop – as much
as 2 to 4GB if working on large
images. Ideally, partition your disk
and dedicate one part to Photoshop.
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Page 41 Dual Brushes offer the user
unprecedented levels of detail

Page 45 The Art History Brush allows
you to turn an image into a painting 

Page 34 Photoshop’s brush editing
system gets the most from Brush tools

Page 35 Access Photoshop’s hidden
extras for more versatility

Page 36 Learn about the importance of
Spacing, Flow and Opacity for brushes 

Page 43 The History Brush offers
superb photo manipulation options



The Brush tool can be found in
the fourth row of Photoshop’s

toolbar. When selected, the options
bar displays quite a few settings for
the current Brush such as Opacity,
Flow and whether it is in Airbrush
mode or not. There are also pull-
down menus for the Apply mode,
Brush Shape preset and the new
Brush Editing palette.

Brushes are used to apply coloured
pixels to an image. They take their
colour from the current Foreground
Colour swatch. The Colour palette
can be used to choose colours in a

number of different ways – by using
the small gradient strip at the base,
the sliders or the Swatch tab.

The Brush tool

Brushes offer some of Photoshop’s most
flexible features. So where can you find them? 
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The Color palette lets you choose colours in
various ways – via a gradient strip, sliders or
swatches, which are located in their own tab

Back and forth
You can set two
colours, a foreground
and background
colour, and switch
between them while
painting with the
Brush tool by pressing
the [X] key.

The Brush presets are
located here at the top-left of
the Options palette when the
Brush tool is selected.

The Brushes palette can be
accessed by clicking this icon
in the Brush tool’s Option bar.

The basic Brush settings,
such as Size, Shape and
Angle as well as the spacing
control can be accessed by
clicking the Brush Tip Shape
section at the top, the
controls of which display at
the bottom of the palette.

The Brushes palette is very
versatile but can seem a bit
complicated at first. It’s far
more advanced than in
previous versions.

Choose the display option
for the presets from the
preset menu. You can display
the presets as a list or as
icons if you prefer.

The panel can be
expanded by dragging the
bottom-right corner.

THE BRUSH INTERFACE AND CONTROLS



Using Brushes

There is a huge range of customisable and
preset brushes. Here’s how to use them
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The key to opacity 
You can also reduce

opacity using the
numeric key pad.

Pressing the 0 key sets
the opacity to 100%,

while pressing the [5]
key sets the opacity to

50%. Pressing the [1]
numeric key sets the

opacity to 10% 
and so on.

Nimble numeracy
To get an intermediate
opacity value like 15%,

type 1 followed 
quickly by 5 on the

numeric keypad.

In this case the paint ‘builds’,
accumulating opacity the more and

more you paint.This is very useful for building
up tones and colours in an image gradually.
You can see the effect clearly here. Where the
strokes double back and cross each other the
colour intensifies.The downside is that the
individual ‘dabs’ are also visible.

4

Flow is like opacity but is a dynamic
property. Whereas opacity sets a value

for the maximum amount of opacity, Flow sets
the minimum amount. With the Flow setting
very low, say 10%, and opacity set to full, you
can paint with what seems like a low opacity,
except when you paint over the strokes you
have just applied.

3

The Opacity of the brush defines how
transparent the paint is – that is, how

much of the colour underneath shows
through the paint. By default it is set to 100%,
but you can reduce this using the Opacity
slider in the Options bar.

2

Once you select the Brush tool you can
choose a Brush Shape from the Brush

preset drop-down menu in the Options bar.
Each preset is saved at a given size, indicated
below the brush preview icon in the preset
list.You can alter this by dragging the master
diameter slider.

1



Using Brushes continued
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Brush size shortcut
You can change the
brush size up and down
in 10 point increments
using the square
bracket keys [ and ].

More shortcuts
On this month’s CD
you’ll find PDF files
that contain all the
possible keyboard
shortcuts for both PCs 
and Apple Macs. .

You can also turn Spacing off using 
the check-box in the Brushes palette.

When it’s off, Photoshop applies spacing
depending on how quickly you draw your
stroke.This can be good or bad, depending
what you want the stroke to look like.

8

In order to counteract this effect, you
need to use an even lower Flow setting.

Here the flow has been reduced to 3% for a
5% spacing value.You can see that the strokes
appear much smoother and build nicely as we
apply more paint.

7

By reducing the Spacing you can get
better results when using a low Flow

setting. Here the Spacing is reduced to 5%,
which means each dab overlaps by 95% of its
diameter.This results in a much smoother
stroke, but its also more opaque, as the brush
tends to ‘self build’.

6

This brings us on to the Brushes palette,
which is opened by clicking the icon at

the top-right of the Options bar.The palette
contains a setting called Spacing.This controls
how frequently Photoshop places a ‘dab’ of
paint as you drag the brush.The default
setting of 25% makes each dab overlap the
next by three quarters of its diameter.
Here’s the result from a low Flow setting.

5
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Brush shortcuts
Lots of Photoshop’s
tools use the same

brushes interface.You
can use the same

shortcuts to change
brush size and pop up
the preset panel with

any of them.Take a
look at the PDF files

included on the CD for
a full list of shortcuts
for both PC and Mac.

Straight ahead
To paint perfectly
straight lines click

once to place the star
point of the stroke

then shift-click
elsewhere. A straight

stroke will joint the
two points.

Also, while painting you can choose a
new colour from the image by holding

down the [Alt] key.The Brush tool changes to
the Eye Dropper, allowing you to sample a
colour from any pixel.

12

When painting an image using brushes
it can be a chore moving to the Options

bar to change brush size and shape. However
the preset pop-up is available right beneath
your mouse if you right-click in your image.
Mac users should hold down [Ctrl] and click
for the same effect.

11

Soft brushes are very useful especially
when used with other tools such as the

Rubber Stamp, which uses the same brush
interface as the Brush tool. A Hardness of
100% is not totally hard, however.There is still
some edge smoothing because of the effect 
of ‘anti-aliasing’ (on the right stroke). If you
want a totally hard brush (left stroke) switch
to the Pencil tool.

10

Other brush properties include
Hardness.This defines how sharp the

edges of the brush are and can be varied from
0 to 100% in the Brushes panel.The brush on
the left has a hardness of 100% while the one
on the right has a Hardness of 0%.They are
exactly the same diameter, but notice that the
soft brush seems smaller because its edges
are less opaque.

9



The Brushes palette is where it
all happens. It’s Photoshop’s

answer to its previous lack of natural
media tools. In truth, it’s not really a
natural media simulation system, but
rather an extension of the brush
dynamics features that previous
versions of the program already had.

When you open the Brushes
palette you are faced with an
overwhelming array of controls and
they do take a while to become
familiar with. Most of the controls
are to do with the ‘dynamics’ of the
brushes – how the brush properties

vary during use. Photoshop allows
you to set the various properties,
such as scattering, colour and hue
variation. These can stay fixed,
respond to cursor speed or fade over
a pre-defined distance. This gives 
you a large additional range of
natural, organic variances to your
brush strokes which would not
otherwise be possible with a mouse.
However, to get the most from the
brush dynamics, and experience
their intuitive ‘feel’, you should
really invest in a graphics tablet and
pen, such as the Wacom Intuos.

Exploring the Brushes palette

The basics of the Brushes palette and presets
and how they affect the look of your strokes 
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Take a tablet
With a graphics tablet
attached, the brush
parameters can
respond to pen
pressure, speed and tilt
(if supported).The
result is that you can
create brushes that are
responsive to your
touch and work more
like real artists tools.
But you can also set up
the dynamics so that
the brushes perform in
a totally unnatural way
too, if you wish.

Brush shape is the final part of the jigsaw when creating and

editing brushes. The standard brushes offer a circular shape

that can be hard or soft, round or oval and rotated at any

angle. But there are a number of special brushes that are

more graphic in nature. These can be selected from the

Preset menu and there are many more that come with

Photoshop but are not loaded by default.To load a preset

library choose one from the Brush preset panel menu (the

triangle at the top-right).You are then asked to Replace or

Append the current list. Append adds the selected library 

to the current list of brushes, rather than replacing it.

CHOOSING YOUR BRUSH SHAPE

Having the right brush shape for the task is the key to success 

The preset brush libraries have many
different brush shapes.The menu is at
the top-right of the preset brush pop-up



There are 13 sections in the
Brushes palette, displayed in a

list down the left-hand side. The first
of these is the Presets section –
essentially a duplicate of the Preset
pull-down menu in the Option bar.
You can choose a brush preset from
the list, or load new ones from the
pop-up menu at the top-right of the
palette. At the bottom is a preview 
of how the current brush stroke
would behave, and above that is the
Master Diameter slider. At the very
bottom are the New Brush and
Delete buttons. Clicking the New

Brush button creates a new preset,
which you can name and save to
reuse another time.

The Brushes palette in detail

Having seen the Brush palette’s potential, let’s
delve deeper into the Brush Preset features 
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The Brush Presets section at the very top stores
complete brush settings, including the type of 
tip shape and the dynamics settings

Saving your presets
You can save the

currently loaded set of
presets as a library

using the Save Brushes
command in the pop-

up menu at the 
top-right corner of the

palette.The library is
saved as a .abr file,

which only Photoshop
can read.

Size Jitter – Controls the
variation in size of the dabs in
a stroke. The higher the value,
the greater the variation.

Minimum – Sets the
smallest size the brush will
reach when it is jittered.

Control – These menus
define what dynamics
attribute controls the
parameter. Fade reduces the
effect of the parameter over a
certain distance, entered in
the numeric field. Other
options are Off, Pen Tilt, Pen
Pressure and Stylus Wheel.

Minimum Roundness – 
Sets the minimum value that
is reached when randomly
jittering the Roundness.

Tilt Scale – Enabled when
the Pen Tilt option is selected
in the Control pop-up.
Adjusts the tilting sensitivity.

Angle Jitter – If the brush is
asymmetrical you can jitter
the angle of the dabs, but not
on a perfectly round brush.

Roundness jitter – This tool
randomly alters the amount
a brush is squashed or
‘rounded’ on one axis.

THE TOOLS OF BRUSH DYNAMICS

Zinio
Note
Insert=TrueAlign=Middle



Scattering

Scattering is a great way of adding random
brush strokes to images. Here’s how it works
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Better late 
than never
Brushes in later
versions of Photoshop
have more options to
control their behaviour.
If you’re using an older
version you may find
that some of the
features that we’ve
mentioned do 
not apply.

Scatter effects
Wide Scatter settings
can be used to create
random but even
variation in tone or
colour on your
artwork. Use it with
selections to control
the placement 
of the effect.

Count Jitter simply varies the number in
the Count setting per dab, and is not

very noticeable in most situations. Note that
there are Control pop-ups in the Scatter
section so you can link the parameters to
graphics pen tilt, pressure and scroll wheel,
or fake the effect of distance.

4

The Count slider multiplies each dab by
the number shown. instead of a single

dab, a setting of 5 in the Count slider will
produce five times as many dabs, each of
which may be scattered. Because it increases
the density of the brush dabs you may want to
lower the Flow setting of the brush.

3

When the Both Axes option is enabled
the scattering takes place perpendicular

to the stroke and along it. Most of the time
you’d leave this option off, unless you want a
very randomized stroke, almost like a spray.

2

The Scattering section is great fun.This
adds a random scattering of the dabs

and is a great way to add random, organic
strokes to images.The Scatter slider controls
the amount of scattering perpendicular to the
stroke direction.

1



Textures and Dual Brushes 

Achieve seriously complex brush effects with
additional features of the Brushes palette
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Precise strokes
Don’t forget gradient
selections are a great
way to control where

‘paint’ will go on an
image.You can blend

or fade away your
strokes very precisely

using these gradients.

Go easy
Dual brushes are the

key to getting more
detailed brush strokes

in less time.They are
more suited, however, to

be used sparsely rather
than as dense strokes.

Enabling Scattering 
is a good idea.

Enabling all of the numerous other
settings and it becomes like playing

with wet paint, and great fun. It only takes
seconds to spray the canvas with incredibly
detailed patterns and colours, and work them
together like real paint.

4

Colour Dynamics takes the concept of
scattering and jitter but applies it to the

colour properties of a brush.You can achieve
very complex and detailed strokes using the
settings in this section.

3

Enabling the Dual Brush option makes
things really interesting.This feature

adds a second brush tip to texture the main
one. It has its own Spacing, Size, Scattering
and Count settings and is mixed in using an
Apply mode chosen from the pop-up menu at
the top of the panel.

2

The rest of the parameters are operated
in much the same way as the Scattering

section that we looked at in detail.The best
thing to do is to experiment with the settings 
by playing around with them. Here the Texture
section is enabled.This lets you add texture 
to the brush tip using one of Photoshop’s
preset textures.

1



The History Brush seems a bit
of a mysterious tool in the

Photoshop toolbox for both
newcomer and veteran alike, and for
that reason is one that often gets
overlooked. This is usually because
veteran Photoshoppers have got used
to the way Photoshop used to work
before the advent of the History
Brush and old habits die hard. 

But it’s worth getting to know this
unusual tool because, together with
its indispensable partner the History
palette, it should turn out to be a
total delight to any newcomer.

Every time you perform an action,
such as painting a stroke, applying a
filter, or deleting a layer, that step is
stored in the History palette as a
‘state’. By clicking on any of these,
you can return your document to the
state it was in at that point. Now,
here’s the best bit – by clicking on
the small icon box next to a history
state in the History palette, you
earmark that layer as the source for
the History Brush. When you then
paint on the image with the History
Brush only those pixels will be
returned back to the earmarked state.

The History Brush

Discover Photoshop’s secret weapon for
retouching and photo manipulation
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Step back in
History
The History Brush lets
you paint previous
states of the current
document over the
current state.This
makes it a powerful
tool for selectively
applying filters 
to an image.

Photoshop 5 onwards has two kinds of undo. There’s the

normal [Ctrl]+[Z] undo ([Command]+[Z] on a Mac), which

undoes and redoes the last action you performed. This can

be handy to flip back and forth, checking the result of your

last action.There is also History.You can step backwards in

History using [Ctrl]+[Alt]+[Z] (that’s [Command]+[Alt]+[Z] for

Mac users). By repeatedly pressing this shortcut, you step

back further and further through the history. To go forwards

again press [Ctrl/Command]+[Shift]+[Z]. Set the number of

states stored in History by going to Preferences > General

and entering a new number in the History States field.

HISTORY AND UNDO

So what’s the difference between Undo and History?

You can set Photoshop’s maximum
number of History states from the
General section in Preferences 



Using the History Brush

The History Brush is a powerful and flexible
tool, but has all the simplicity of a normal brush
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Size does matter
To paint with History

states the source state
must be the same size

as the current
document. if you

resized an image you
will not be able to use

any states prior to
that as a source for

the History Brush.

United states
In order to paint with

History states, the
source state must also

be the same colour
space. If you changed

this you will not be
able to use any states
prior to that point as

a source for the
History Brush.

Now we can change the History source
to the Inverted state, select the History

tool and a fancy brush and paint. Wherever we
paint the pixels in the image will be inverted.
Obviously you can use this technique with any
effect, filter or adjustment you like.

4

We want to get the image back as is was
so that we can selectively invert it, but

undoing the last step also clears the state
from the History, which is no good. Instead we
mark the uninverted state as a History source.
Choose Edit > Fill and set the Fill mode to
History, et voilá, back to normal but with
History intact.

3

Typing [Ctrl/Command]+[I] inverts the
image, turning the shades and colours

to their opposites.This will be be the basis for
the effect we want to achieve using the
History Brush, and it has been saved as a state
in the History palette.

2

A good use of the History Brush is to
apply an effect to an image in localised

areas without the need to construct a mask or
selection first. Here’s our starting image to
which we want to apply some special effects.
First of all we resized it to make it a bit smaller.

1



Using the History Brush continued
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Filter tip
You can use this same
technique of Brushing
using History to
selectively apply any
filter to an image.

Early edits
In earlier versions of
Photoshop you could
open part of a large
image and edit it,
placing the edited
part back into the
large image once
finished.That was in
the days when RAM
was expensive.

Now we select the Gaussian Blur state
as the source for the History Brush and

paint in the image precisely where we want it
to be blurred, leaving the unblurred pixels
intact to create a forced ‘depth of focus’ effect.

8

Now we return the image to its original
state by selecting the unblurred state as

the History source then using the Edit > Fill
command set to History mode.

7

So, we follow the same steps as before
except this time we blur the whole

image by Applying the Gaussian Blur filter
instead of inverting it.

6

Here’s another example of the same
technique. We’ll use History to fake a

‘depth of field’ blur effect on this 3D image.
Normally you might do this using a depth
render as a mask, but what if you forgot to
save one?

5



Art History Brush

The History Brush has an even more creative
cousin – meet the Art History Brush
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Historic detail
Even if the detail has

been obliterated, you
can bring it back by

using a smaller brush,
because the original,

untouched image is
used as the source.

Pick a mode
The Art History Brush

can be applied in
different blending

modes: Darken,
Lighten, Hue, Colour,

Saturation 
and Luminosity.

You can carry on adding details back,
changing brushes and styles until you

get the result you want. Here we went back
and lightened the original image then used
this as the source, enabling us to add in some
detail in the darker part of the face.

4

That blocks out the image nicely. Now
we can paint some of the finer details

back in. Changing the brush to a much smaller
radius lets you add back some details, but you
can do this only to certain areas. We’ve used a
3-pixel brush, and the Loose Medium Style
from the History Brush’s Options bar.

3

Here’s how it works. Open any photo,
preferably one that will work well as a

painting.You don’t need to perform any
action to set things up, just select the current
state as the History Source and select the 
Art History Brush. We used the Impressionist
preset from the pop-up menu at the very
top-left of the Options bar and painted over
the image.

2

The Art History Brush is one of those
bizarre but fun features Adobe comes

up with once in a while. Basically, it is used to
convert any image into one that looks hand-
painted.The original photo is on the left, and
the Art History conversion on the right.

1



Chapter 4

USING THE
CLONING AND
HEALING TOOLS

Cloning is a very simple and
obvious concept in image

manipulation. Take pixels from over
here and duplicate them over there.
That’s really all there is to it. The
Clone tool, also known as the
Rubber Stamp, is Photoshop’s
implementation of this technique
and offers you a great deal of power
for retouching images.

The tool works by ‘sampling’
pixels at one location in an image, 
or even in a different document
altogether, and painting them in a
different location using what is
essentially a brush. The Clone tool
offers most of the properties of the
normal Brush tool – size, hardness,

In this chapter…

L e a r n  h o w  t o  w i e l d  t h e
C l o n e  t o o l  ( R u b b e r
S t a m p )  l i ke  a  p r o

U s i n g  b l e n d i n g  m o d e s
t o  g e t  b e t t e r  r e s u l t s
w h e n  c l o n i n g  d i f f i c u l t
t e x t u r e s  l i ke  s k i n

L e a r n  h o w  t o  c l o n e
p i xe l s  b e t w e e n
d o c u m e n t s

Wo r k i n g  w i t h  t h e
H e a l i n g  a n d  P a t c h
t o o l s  t o  i m p r ov e
p o r t r a i t s  a n d  p h o t o s

P e r f o r m  s p e c i a l
e f f e c t s  a n d  i m a g e
m a n i p u l a t i o n  t r i c k s
u s i n g  C l o n i n g

The Cloning and Healing tools in Photoshop
offer an elegant way to fix damaged photos,
correct bad scans and generally clean up 
your images.They’re great fun to use too

tip shapes, dynamics and blending
modes, but applies these to cloning.
In addition to these the Clone tool
lets you clone not only pixels from a
single layer but from the whole of a
multi-layered document. This can be
a very powerful feature for advanced
users but can cause problems if you
don’t keep your wits about you.

Seamless sampling
When sampling pixels from a multi-
layered, composite image you must
be aware of any Adjustment layers
present. If you sample a composite
image with say, a Hue/Saturation
Adjustment layer applied to it,
boosting the saturation, cloning on



to layers below this adjustment layer
will result in the cloned pixels being
boosted twice. If your intention is to
have a seamless result, your hopes
will be dashed, so it always pays to
be aware of this.

In version 7 of Photoshop, Adobe
introduced a tool that takes the
concept of cloning to the next level
in terms of ease of use, known as the
Healing tool. Cloning is a great tool
to have but as we saw earlier, it can
take some effort to get a seamless
result, especially when the sample
point pickings are slim and when
dealing with multi-layered images. 
It can take quite a bit of practice to
achieve smooth results. 

Healing, however, lets you clone
pixels over a problem area but rather
than simply overlaying them, as the
Clone tool does, it blends them with
those they are replacing, using some
clever algorithms. 

Skin care
As you may have guessed, the
upshot of such technology is that
you don’t need to be nearly so
careful in your cloning – when
blending the blemishes on the face
of a subject in a portrait, for
example. The Healing tool will
intelligently blend the pixels to get
the best result (at least most of the
time), which works well on skin.
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Page 52 The new Healing tool can
make someone look years younger

Page 51 Revive damaged photos and
images with cloning techniques

Page 53 The Healing Patch tool is a
great way to fix up photos 

Page 48 Cloning copies parts of your
image and transplants them elsewhere 

Page 49 The Clone tool can remove
unwanted parts of an image

Page 50 Less-than-perfect portraits 
can be fixed up in seconds 



The Rubber Stamp (Clone) tool

The Rubber Stamp tool is useful for copying
pixels from one part of an image to another
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Sample mode
When you hold the [Alt] 
key down the Clone
cursor changes from
the brush outline to
crosshairs to show that
it’s in sample mode and
allowing more 
precise sampling.

Precision painting
Use the Caps Lock key
on any brush tool to
activate Precise
Cursor mode.

Now we can clone the boy. Releasing
the [Option] key returns to normal

cloning mode. We can clone over the face of
the boy at the top-right, replacing his with the
face of the boy from the lower-left. We can
carry on and make as many clones as we like.

4

Selecting a 20-pixel soft brush we first
set the Sample point from which to

clone.To do this we hold down the [Alt] key
and click where we want to sample from – in
this case the face of the boy in the lower-right
of the photo.

3

To ensure that we can easily return to
the original if necessary, we first make a

copy of the image as a new layer. Selecting the
Clone tool we can see the Options bar looks
much like the Brush tool’s. At the far right are
two extra options though: Aligned and Use 
All Layers.Turn off the Aligned check-box.

2

Let’s focus on the more creative and fun
aspects. Here’s a great example of what

cloning is all about – our source image is a
typical group portrait.

1



Removing unwanted elements

Cloning is ideal when you need to seamlessly
eradicate an unwanted part of an image
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In the right
measure

Use the Measure tool
to drag along the top

edge of one of the
bench slats to read its

angle, then use the
Edit > Transform >

Rotate command.The
angle that you 
just found will

automatically be
entered in the 
rotation field.

Online tutorials
You’ll find a host of

handy tutorials to help
you take your

Photoshop skills further
at the website of our

sister magazine,
Computer Arts.

www.computerarts.co.uk

With a bit of effort we can remove the
man entirely from the image. Note that

to do this successfully we need to stop when
the alignment of the image begins to drift,
and take a new sample point.

4

It sort of works but the cloned part of
the bench does not line up properly

with the original.To fix this we can undo the
cloning, rotate the image slightly so that the
slats are horizontal, and clone again.This time
they line up.

3

This time we make sure the Aligned
option is enabled.This allows us to use

multiple strokes, and to maintain the offset so
that the cloning is consistent. In a duplicate
layer we set the sample point on to the middle
of the park bench and begin cloning out the
man on the left.

2

Another great use for cloning is for
removing objects from a picture. Here’s

an example image. Perhaps you wanted to use
the image with some text overlaid on one side,
or you just need to change the composition.

1

http://www.computerarts.co.uk


One of the most common uses
of the Clone tool is to fix

blemishes, bruises and marks on
skin. If you want to fix marks on the
skin such as a rash or the occasional
spot you can easily clone it out using
the Clone tool as normal. While
you’ll remove the blemish you’ll
probably find it very difficult to get
a seamless clone. What tends to
happen is that the clone will be
slightly the wrong shade or colour,
so that when you zoom out to
inspect the whole image, the cloned
point is almost as visible as the

original blemish, which defeats the
whole point of removing the blemish
in the first place!

Cloning Skin

You can fix problem portraits in seconds using
the Clone tool and its subtle blending mode

50 FOCUS GUIDE – ADOBE PHOTOSHOP TOOL TECHNIQUES

Chapter 4

Fixing skin in photos is easy, once you know that
the secret is simply to change the Clone tool’s
blending mode and subtly clone out the marks

A cloning
alternative
An alternative
technique, which uses
the same principal, is
to clone on to a new
layer using the
Normal mode but set
the layer’s blending
mode to Colour 
or Luminosity.

Less is more
Using a low opacity
allows you to clone
away blemishes
gradually.
You don’t always
need to eradicate
blemishes totally. In
fact, doing so can
look  too fake. Instead
just reduce their
intensity a little.

CLONING SKIN correctly requires careful use of the brush blending

modes. In the Options bar set the blending mode in the drop-down

menu to Luminosity and the opacity to 50%.You can then clone the

image using only the brightness of the sampled point.This lets you get

rid of light or dark blemishes easily, without changing the colour.

IF THE blemish is a red patch of skin or bruise, set the blending mode to

Colour before you clone.That way the brightness of the pixels remains

the same, but the off-colour will be removed.

MAKING USE of both apply modes in turn is likely to be the best 

option for very bad marks like cuts and bruises.This allows you to deal

with the colour and brightness independently.

WITH BOTH methods try to keep the sample point as close as you can

to the problem area to minimize the difference in skin tone.

THE TRICKS FOR SKIN CLONING REVEALED



The Healing Brush

No time to fuss with the Clone tool? Then fix
up an image with the Healing Brush instead
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Extreme healing
The same technique

of setting the
blending mode to

either Colour or
Luminosity instead of

Normal works with
the Healing tool just
as well as the Clone
tool, but you’ll only
need it for extreme

situations when the
built-in blending

algorithm doesn’t
quite cut it.

Sample and
Pattern

The Healing tool
works in two modes:
Sample and Pattern.

In Sample mode it
works like the Clone

tool, while in Pattern
mode it blends the

pixels with one of
Photoshop’s stored

patterns.The uses for
this mode are less

obvious, but useful for
certain effects.

The Healing brush has different
blending modes which you can choose

from the Options bar drop-down menu, 90%
of the time you won’t need to use them.

4

Using the Healing brush instead results
in a totally invisible repair.There’s no

need to change blending modes or opacity,
just set the sample point using the [Alt] key
then click and drag over the damage.

3

Using the Clone tool works, but leaves a
very slight, but noticeable mark behind

due to the sampled pixels being a sightly
different shade. We could use more advanced
techniques, but why bother when the Healing
brush is at hand?

2

The Healing Brush can be found in the
fourth row on the toolbar, and looks like

a plaster. It uses the same sampling principal
as the Clone tool but works by blending the
original and cloned pixels together to create a
near-perfect fix. Here’s an image that needs a
bit of a repair.

1



The Healing Patch tool

If you don’t like using brushes and selections
are more your thing, try the Patch tool 
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No smear
The Healing and Patch
tools can smear if they
are near to very dark
pixels.Use a selection to
protect the area you
want to fix if 
smearing occurs.

When you release the mouse button,
the pixels will become merged with

those below. Photoshop performs its trick
intelligently, so the dark area vanishes but 
the skin tone looks normal. We can repeat 
this on the other eye to complete the anti-
ageing process.

4

Because Destination mode is enabled
we can drag these selected pixels onto

the destination pixels. As you drag a copy of
the pixels, the selected area moves with the
mouse as a visual cue – you are actually
cloning the pixels.

3

With the Patch tool selected we lasso an
area of clean skin texture, just below the

eye we want to fix.That area is highlighted
with the familiar marching ants.

2

The Patch tool can be found in the same
tool group as the Healing Brush, but it

has fewer options.The most logical mode to
use is Destination, so this is how we have it set
for now. We want to make the man in this
photo look a bit younger by removing the
bags under his eyes.

1
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Large patches
The Patch tool can be

useful when
attempting to repair

very large areas in
one go. It’s much

quicker than using
the Healing Brush too.

Select then Patch
If you need to, you can

make the selection
before you choose the
Patch tool.This means

that you can use any of
Photoshop’s advanced

selections tools, such as
Quick Mask, Colour
Range or the Magic

Wand to preselect the
area you require 

more precisely.

When you are happy with the selected
area you release the mouse.The

selection snaps back to its original location
taking the source pixels with it.When
Photoshop blends the two, the line vanishes.
Here’s the result on both eyes.

4

Now all you need to do is to drag the
selection over the pixels you want to

use to fix the problem area.This time only the
selection outline moves, not the pixels that are
selected, as is the case in Destination mode.

3

When in Source mode you need to
select the pixel that you want to change

first, as opposed to selecting the pixel you
want to use to fix the problem area. Here we
drag around the line under the left eye using
the Patch tool to select it.

2

The Healing Patch tool works the
opposite way round when in Source

mode. Depending on your way of thinking,
Source mode may seem less intuitive. We will
perform the same trick of removing lines
under the eyes in this image but use Source
mode instead.

1



Chapter 5

THE GRADIENT,
FILL AND
ERASER TOOLS

Gradients and Fills are such
simple tools in Photoshop that

their simplicity can often hide their
power, especially in the hands of an
experienced Photoshop user. 
A Fill is simply a way to pour a
single flat colour, pattern or history
state into a selected area, or the
whole canvas. Like most of the tools
in Photoshop, there is more than one
way in which to accomplish a Fill;
we’ll explore some of these different
techniques later on in this chapter.

Gradual benefits
The Gradient options are even 
more powerful than Fills. With the
Gradient tool you can create a fill

In this chapter…

L e a r n  t o  u s e  a n d
c o n t r o l  G r a d i e n t s  

C r e a t e  C u s t o m
G r a d i e n t s , u s i n g  t h e
g r a d i e n t  e d i t i n g
features in Photoshop 7

U s e  t h e  P a i n t  B u c ke t
t o o l  t o  f i l l  a r e a s  w i t h
a  c o l o u r, p a t t e r n  
o r  h i s t o r y

U s e  G r a d i e n t s  a n d
Fi l l s f o r  s p e c i a l  e f f e c t s
a n d  i m a g e
m a n i p u l a t i o n

R e m o v e  a  s u b j e c t  f r o m
i t s  b a c kg r o u n d  u s i n g
t h e  B a c kg r o u n d  a n d
M a g i c  E r a s e r  t o o l s

Once you get more competent with
Photoshop you’ll appreciate the importance of
these utility tools.The Gradient tool in particular
is essential for all manner of tricks and effects

that gradually changes colour.
Gradients come in all kinds of
different shapes: Linear, Radial,
Angular, Reflected and Diamond,
and this makes them very useful for
a variety of different situations.

The Gradient Editing feature in
Photoshop enables you to create
gradients with two or more colours.
You can have a simple white-to-
black gradient, or a whole rainbow
of colours. For special effects work
the simple black and white gradient
is absolutely indispensable, putting 
a whole range of additional options
at your disposal. For example, if you
want an effect to smoothly fade 
from full strength to invisible then



it’s easy to use a white-to-black
gradient to control this, usually as 
a layer mask. 

Photo perfection
For photographers, coloured
gradients can play the role of custom
filters, making it easy to create
sultry sunsets or brooding, stormy
skies at the drag of a mouse. If you
combine gradients with alpha
channels you have the power user’s
playground. The ability to construct
complex masks and selections using
alpha channels and the Gradient tool
is unparalleled.

While the Fill and Gradient tools
are concerned with adding pixels to

an image, the next family of tools
that we’ll look at does quite the
opposite. The Eraser tool lets you
remove pixels by simply using a
brush, like an anti-paint brush,
which enables you to paint away
pixels on a layer leaving nothing but
transparency behind. The power
version of the Eraser is the
Background Eraser. This tool is
designed to make the extraction of
subjects from their background a
relatively simple task. Don’t be
fooled though – it’s still a tricky
proposition, but we’ll show you how
to avoid the pitfalls of this technique
so that you can achieve the best
possible results every time.
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Page 64 Blend two or more image
layers together with Gradients 

Page 62 Use gradients and blending
layers to simulate photographic filters

Page 66 Learn how to avoid the pitfalls
of the Background Eraser tool

Page 56 Learn how to fill colours in an
image using the Paint Bucket tool

Page 57 Fill with 50% grey for special
effects and image enhancement

Page 59 We look at the Gradient tool
and its various options



The Paint Bucket

The Paint Bucket tool lets you pour pixels 
into any selection, and it has a few tricks too
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Missing Paint
Bucket?
Photoshop’s toolbar
has undergone many
revisions over the
years, so the Paint
Bucket may be
located elsewhere in
older versions.

Select and fill
Save time by using
the Paint Bucket in
one fell swoop,
instead of using the
Magic Wand to make
a selection and 
then filling it.

Instead, what happens is the same as
with the Magic Wand tool.The Paint

Bucket searches for similar coloured pixels 
to fill, within the tolerance that you set, rather
than covering the whole layer. Increase the
Tolerance setting in the Option bar to fill a
wider range of colours.

4

However, the Paint Bucket has more in
common with the Magic Wand than you

think. If your selected area already has image
pixels in it, clicking on the image will not
necessarily fill the whole selection or layer.

3

It can operate in Foreground Colour
mode or in Pattern mode, which you

choose from the drop-down menu in the
Options bar.You can then select a pattern
from the drop-down presets menu, also in the
Option bar, and click in the image to fill it.

2

The Paint Bucket can be found in the
sixth row of the toolbar in Photoshop 7,

in the same tool group as the Gradient tool.
If you make a selection you can use this tool 
to fill it with the current foreground colour.

1
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In the mode
In Overlay mode 50%
grey pixels are totally

transparent. Pixels
brighter than 50% are

applied in Screen mode,
while those darker than

50% are applied in
Multiply mode.

Video tutorials
On the CD this month

is a set of video
training tutorials

created by our very
own Photoshop guru,

George Cairns. If you
want to learn more

about using every
tool  in the Photoshop

toolbar, you’ll find 
your CD invaluable.

The layer is filled with the grey, by
making sure the Use All Layers option is

off and clicking in it. Now we can set the Layer
mode to Overlay and apply the noise, blur it
slightly, then change the opacity of the layer
any time we want to control the effect.

8

We need to soften the noise, by blurring
it but not the image. So we need to

apply the noise in a layer above the image.
However, the Noise filter does not work on a
transparent layer. Enter the Paint Bucket.
The Foreground Colour is set to 50% grey
using Colour Picker and setting Lab Lightness
to 50, A and B to 0.

7

Another use for fills is for special effects.
An example is for adding noise to a 3D

or digital image to make it look more like
photographic film.We could simply apply
noise to the image directly but this limits our
options later if we want to change the noise,
say, to make it less obvious. Applying the
noise as-is also tends to looks fake.

6

Using a lower tolerance you can build
up the fill by clicking a couple of times

on different areas of the image. In this example
we did so in a new layer.You have to make
sure the Use All Layers option is checked
when using a transparent layer for the fill.
Applying the layer in Color mode allows us to
change the colour of the girl’s kagool.

5



The Paint Bucket enables you 
to fill areas using a tolerance

setting like the Magic Wand tool. 
It also has settings to fill contiguous
pixels – or not, as the case may be.
Enabling the Contiguous mode in
the Paint Bucket tool’s Options bar
(this is the default setting) only fills
pixels that are both within the
tolerance and physically connected
in the image. Disabling this mode
causes the Paint Bucket to search
over the whole image for pixels
similar to the one that you click on.
The Anti-aliasing option simply

means that the edges of the fill are
smoothly anti-aliased to remove any
unsightly jagged edges.

More Fill options 

The Paint Bucket is just one of a number of ways
in which you can fill an image or selection
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The difference between the smooth anti-aliased
fill (green) and the jagged non-anti-aliased fill
(pink) is quite obvious in this close-up

Fetching patterns
Custom fill patterns can 
be found on the web.
Here’s the address of a
site where you can
download free
Photoshop patterns:
http://graphicssoft.about.
com/library/free/
blfree_pspatterns1.htm

Keep it cool
Fills and patterns are
useful for creating
backdrops for web
pages. Be careful
though, because
patterned backgrounds
can be very distracting,
so keep them as subtle
as possible.

YOU CAN fill using the current foreground colour by typing [Alt]+

[Delete].Typing [Ctrl]+[Delete] (or [Command]+[Delete] for Mac users)

will fill using the current background colour. Pressing the [D] key reverts

the colour to the default black and white.

ANOTHER WAY to fill is using the Edit > Fill menu command.This has a

few extras, such as a pop-up menu for choosing to fill with either White,

Black, Foreground or Background colour, or the handy ‘50% Grey’.

THE FILL Command also enables you to fill using the earmarked 

history state in the History palette.You can furthermore set it to Pattern

mode and choose a pattern from within the Fill dialog.

CHOOSE YOUR pattern from one of Photoshop’s presets or use your

own custom-made pattern if you prefer. Any rectangular selection can 

be stored as a pattern using the Edit > Define Pattern command.

FILLING TIPS

http://graphicssoft.about.com/library/free/blfree_pspatterns1.htm


The Gradient tool

The Gradient tool is indispensable when
working on multi-layered documents
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Degrees of
constraint

Hold down the [Shift] 
key while dragging to
constrain the angle of 

your gradient to 
45-degree increments.

Gradient presets
While using the

Gradient tool right-click
to pop up the gradient

presets palette. Mac
users will need to press

[Ctrl] instead.

The distance you drag will define the
width of the gradient. It can by very

tight if you only drag a little way (top) or very
loose if you drag a long way (bottom). Note
that before the first point the pixels are made
up of 100% first colour, and after the last point
they are 100% last colour.

4

The Gradient tool can be found in the
sixth row of the toolbar, and has an icon

with a small black-to-white gradient. Use the
tool by simply dragging out a line indicating
the direction of the gradient.The first point
you click defines where the first colour will
end, and the point where you release the
mouse after dragging is where the second (or
last colour if it has more the two) will begin.

3

...or colourful, like this red-to-green
gradient.You can also blend a

monotone colour, like black or white into a
colour such as red, and the brightness and
saturation of the colour will smoothly blend
across the distance that you specify.

2

A gradient is very simply two colours
spread over a distance and smoothly

blended from the one to the other.They can
be monotone, like this simple black-to-white
linear gradient…

1



The Gradient Tool continued
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See-through
options
The Transparency
check-box in the
Options bar allows you
to turn off the
transparent part of a
gradient if it is enabled.

Make it noisy
The Dither check-box
enables a dithering or
jitter to the gradient,
adding a touch of
noise, which can help
reduce banding
effects when printing.

Custom gradients can contain any
number colours that you specify and

are edited in the Gradient Editing panel.They
can also incorporate transparency. Here is a
custom preset that combines a multicolour
gradient with alternating transparency.

8

Foreground to Transparent takes the
current foreground colour and blends 

it to nothing, leaving only transparent pixels.
This can be great for blending gradients over
images, for example.

7

Foreground to Background mode
simply uses the current foreground

colour as the first point, and the current
background colour as the last point and
creates a blend between them.

6

There are actually three types of
gradient. Foreground to Background,

Foreground to Transparent, and Custom. Each
type is selected from the preset pop-up in the
Gradient tool’s Option bar.There are usually a
number of preset custom gradients available.

5



When the Gradient tool is
selected, clicking on the

preset sample at the top-left of the
Option bar opens up the Gradient
Editor panel. Here you can choose
from a range of ready-made
gradients, or create your own.

To create a custom gradient just
select a preset and begin editing the
colours of the ‘nodes’ in the editing
strip at the bottom of the panel. 

The top of the strip contains the
transparency nodes, while the
bottom contains the colour nodes.
Click on a node (or ‘Color Stop’ as

Adobe calls them) to edit its colour.
The Stops section lets you edit 
the properties of the selected stop.

The Gradient Editor panel

Editing gradients is done in the Gradient Editor
panel in Photoshop 6 onwards
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Clicking on a colour node, (or ‘Stop’ as Adobe
calls them) in the gradient strip at the bottom 
of the panel selects it for editing.

Changing stops
Creating new stops is

done by clicking in free
space above or below

the gradient strip.To
remove a stop,

drag it away and let go.
Stops can be moved by

dragging them 
left or right.

The Preset list is displayed
at the top. You can change
the size of the previews from
the panel’s pop-up menu.

You can change the type 
of gradient from the pop-up.
The options are Color
(normal) and Noise.

Create a new preset from
the current gradient strip by
clicking on this button here.

The Color Stops (or nodes)
are displayed underneath the
gradient strip. Click on one to
select it for editing. Clicking
where there is no stop
present adds a new one.

the Transparency Stops 
are displayed on top of the
gradient strip. They can be
either white, black or shades
of grey only.

When you select a Colour
or Transparency Stop its 
mid-point handle is also
displayed. Drag this to
change the rate of blending
between nodes.

THE GRADIENT EDITOR EXPLAINED



Using Gradients creatively

Now let’s look at how useful Gradients can 
be when working creatively in Photoshop
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Trial and error
Experiment with all the
Layer Blending modes
and get a feel for how
they affect the image.
Some will have similar
pleasing effects, while
others will just look
plain awful.

Comprehend 
the blend
There are technical
explanations for each
of the Blending modes
in your Photoshop
Manual or online
guide. It's worth going
through these to
understand exactly
what's going on.

In a new layer, we add a Foreground 
to Transparent gradient once more, but

choose a much darker blue.The layer mode is
this time set to Multiply, creating a dark cast
over the image. Finally, a Levels Adjustment
Layer is added to the image, which controls 
all brightness and gamma.

4

Another use for gradients is to add
mood to a Photo. Here’s an image of a

model looking quite moody, but the picture
itself could be even moodier. It’s simple with 
a gradient to add that mood.

3

In a new layer we add a vertical dark
blue transparent gradient over the

image. Setting the layer’s blending mode to
Overlay blends the colour and brightness of
the gradient in a special way, creating a
deeper, darker sky.

2

Gradients are great for those working
with digital or scanned photographic

images in Photoshop. We can use gradients 
in place of traditional photographic filters to
create some cool effects. Here’s the original
unfiltered image.

1



Gradient Styles

The Linear gradient is only one of five styles.
We’ll look at the others and see what they offer
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Turn it around
The invert button in the

Options bar reverses
the direction of the

colours in the gradient.

Quick sample
Use the [Alt] key to

activate the Eye
Dropper.You can then
choose colours for the

gradient from 
your image.

Finally, the Diamond style is similar to
the Radial style, except that the edges

form a square rather than a smooth circle.
This can be useful for certain kinds of vignette
effects, for example.

4

Next up is the Reflected style.This type
of gradient can be useful, especially for

creating masks and selections. In this case a
Linear gradient is created, but in opposite
directions from where you drag.

3

The next style option is the Circular
style.This is not a common one to use,

but can be useful. In this case the gradient is
wrapped around in a circular motion.The line
you drag doesn’t mark the size of the
gradient, but only the direction of the colours.

2

At the top of the Gradient tool’s Options
bar next to the preset pop-up are the

Gradient Styles. Linear is the default, but next
to it is the Radial style. Selecting this creates 
a radial gradient using the selected preset.
The first point you click is the center of the
gradient, dragging outwards to the edges.

1



Gradient Masks

Use a simple black and white gradient in a
layer mask for creating composite images
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Application
options
You can apply masks
to adjustment layers as
well as normal image
layers. So we could
have applied the levels
as an adjustment layer
using the same
gradient trick to mask
out its effect on the
lower part of 
the image.

Vignettes 
Create vignettes using
a Radial gradient as a
layer mask applied to
a Solid Fill Layer.You
can then adjust the
colour of the fill to suit
different uses.

Finally Image > Adjustment > Levels 
is applied to the Sky layer (not to the

mask). In the dialog box that appears, drag up
the black input slider to darken the sky and
making it match better with the image below.

4

A layer mask is added to the Sky layer,
by clicking the New Layer Mask button

at the bottom of the Layers palette. Making
sure the layer mask is selected and not the
layer, we can use a black-to-white linear
gradient to mask out the bottom of the sky
layer, blending the two images together.

3

One image is copied into the other by
dragging its layer from the Layers

palette over the other’s image window and
releasing the mouse.The sky image is scaled
roughly to fit using the Free Transform tool.

2

One very popular use of the Gradient
tool is to make one image blend

smoothly into another. Here are two images
that we want to composite, by blending one
gradually into the other.

1



Because Photoshop handles
transparency as a mask, a

simple black and white gradient can
be used to smoothly manipulate
layer transparency. Photoshop also
enables us to convert a mask into a
selection and vice-versa.

For example, you can create a
gradient selection by switching to
the Channels palette, creating a new
alpha channel and drawing a
gradient in it. Then by [Command]+
clicking on the alpha channel, it can
be loaded as a selection: black areas
are unselected, white areas are fully

selected, shades of grey are partially
selected, depending on brightness.
So loading a gradient in this way
creates a variable selection, through
which we can apply filters, paint or
whatever. Another way to do the
same thing would be to enter Quick
Mask mode, apply the Gradient tool
on the Quick Mask, then press [Q]
to convert it to an active selection.

Once a gradient selection is made,
you can convert it to a layer mask
simply by adding a layer mask to a
layer with the selection active. 

Masks and selections in detail

We’ll look at some different ways to create
gradient masks and selections
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Goodbye halo
If applying a filter such as

Gaussian Blur through a
gradient selection it’s best to

apply the filter multiple
times with a small value.
Otherwise you will get a

‘halo’ around the partially
selected pixels rather than a

smooth blur.

As we’ve seen, we can use gradients as layer masks when

compositing images. We can also apply gradients to layers

using blending modes to get different effects. Another use,

which is sort of between the two, is to control the effects of

an adjustment layer with a gradient mask. It helps to make

the gradient selection first, as described above, then add

your adjustment layer. Unlike pixel-based layers, adjustment

layers are created automatically with a layer mask. Any

current selection will become the layer mask for this new

layer. Make the adjustment, such as increasing the contrast,

and see the results as applied through the mask directly.

GRADIENT LAYER MASKS WITH ADJUSTMENT LAYERS

Here’s another handy way of using Gradients

A Hue/Saturation Adjustment Layer is
applied to this image using a gradient
layer mask



Magic and Background Erasers 
One is like the Eraser and Magic Wand in one,
while the other is ideal for cutting out objects 
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Know the limits
In all honesty the Magic
Eraser is not one of the
best tools in
Photoshop's arsenal. It
can be useful for
quickly erasing
something but only
works well on a limited
range of images.

Look elsewhere
There are a number of
third party tools
available that do a
better job at removing
backgrounds than
Photoshop’s
Eraser tools.

Our Dog image proves to be far more
difficult a proposition, however.

Although the Magic Eraser works fairly well 
on the sky, on the grass it doesn’t do so well.
This is because the grass is so varied in colour
and brightness that the Eraser has a hard job
of finding the right colours to remove.

4

After a couple of clicks the whole
backdrop is erased, leaving a nice 

clean-edged subject surrounded by
transparent pixels.This is useful if you then
want to save the image as a GIF for example,
with transparency intact.

3

Alternatively you can cut out the middle
man (or woman as is quite literally the

case here) by using the Magic Eraser tool. With
this tool you can click on the background to
erase it directly in one click. All colours that
fall within the tolerance setting are deleted.

2

In an image such as this it is fairly easy
to remove the subject from the

background because there is a definite
difference in colour between them. Photoshop
has many ways of doing this, you could make
a selection using the Magic Wand tool then
delete it, for instance.

1
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Background
details

Like the Magic Wand,
the Background Eraser
has a Tolerance setting

but also Limits and
Sampling Method

options. Continuous
lets you sample as you

paint, while the Once
option samples only

on the first click.
Background Swatch

lets you save a colour
to use as the sample.

Glitch invasion
The Background Eraser

is not a tool that a
professional Photoshop
user would feel at home

with. It tends to leave far
too many glitches in the

edge of the cut-out
objects, which take extra

time to fix up later.
It’s still slightly messy, but the bulk of
the rest of the background can be

deleted using a rough selection. It’s the bits
near to the subject that cause the problem,
and the Background Eraser does a pretty
good job of keeping the parts you want and
deleting those you don’t.

8

The tool has a boundary like a normal
brush and a central cross. When you

paint you must keep quite close to the edge 
of the object you wish to keep, without
actually touching it.The tool samples and
erases as it goes, but does so only within the
brush area. If you slip and accidentally cross
over onto your object then it will be deleted,
so care is required.

7

Using the Background Eraser tool 
(you’ll find it in the Eraser tool group in

the sixth row of the toolbar) results in a more
controllable method of chopping the pooch
out of his environment.The tool is brush-
based, so you simply paint away to remove
the background.

6

Turning off the Contiguous option
might improve matters.This makes 

the tool search the whole image for similar
colours, rather than just examining pixels 
that are connected to the starting point.
Unfortunately we end up losing most of our
dog as well when we try this method.

5



Chapter 6

GETTING TO
KNOW THE
EFFECTS TOOLS

When it comes down to it,
Photoshop is mostly about

effects. Be it a simple vignette, a
crop or even an image enhancement,
what you are really doing is creating
some kind of effect to spice up an
image. Photoshop’s filters offer you
a broad palette of effects, which can
be applied to images, both very
subtly or dramatically. Combine
filters with selections and masks,
layers and blending modes and you
have a cornucopia of digital tricks
that can improve an image no end.

Photoshop also has a small group
of effects-based tools which work in
a similar way to the filters and
adjustment features in many

In this chapter…

B l u r  o r  s h a r p e n  p a r t s
o f  a n  i m a g e  u s i n g  t h e
‘ f o c u s ’ t o o l s

C r e a t e  f i n g e r - p a i n t i n g
e f f e c t s  o r  b l e n d
c o l o u r s  u s i n g  t h e
S m u d g e  t o o l

C r e a t e  b e t t e r
c o m p o s i t e  i m a g e s
u s i n g  ‘e x p o s u r e ’ t o o l s

M a ke  y o u r  s u b j e c t
s t a n d  o u t  w i t h  D o d g e
a n d  B u r n  e f f e c t s

Photoshop’s effects tools include Blur, Sharpen,
Smudge, Dodge and Burn.We’ll look at how
best to use them to spice up your artwork,
composites and photographic images

respects, but do so in a more
artistically controllable way.
Essentially these are brush-based
filters, allowing you to ‘paint’ the
effects just where you need them.

Focus and exposure 
Effect tools are in two different
groups. The ‘focus’ tools are in the
seventh row of the toolbar in
Photoshop 7 and consist of the 
Blur, Sharpen and Smudge tools.
‘Exposure’ tools are directly to the
right of this and contain the Dodge,
Burn and Sponge tools. Click and
hold on the groups to reveal all the
tools in that group. You’ll also note
that next to each tool is a letter. This



is the tool’s shortcut key, and there 
is one for almost every tool in
Photoshop’s toolbar. Pressing that
key will activate the respective tool
no matter what else is selected.

The ‘focus’ tools – Blur and
Sharpen – allow you to apply these
filter-like effects directly to pixels in
the image using any of Photoshop’s
brushes – including the complex,
customisable brush shapes. But most
of the time you’ll find it best to use
these tools with a normal, soft,
round brush. The Smudge tool works
in a slightly different way, however,
and we’ll look at how to use that
particular tool more closely later in
the chapter.

The ‘exposure’ tools – Dodge,
Burn and Sponge also let you paint
their effects onto an image directly.
These tools produce effects similar
to the Adjustment tools like Levels,
Curves and Hue/Saturation.

Shadow play
Using the exposure tools is an
excellent way of producing photo-
realistic composites. The tools
enable you to paint additional
shadows or highlights in precisely
the right areas, to give composited
elements the correct shading. The
shadows will then look like they
really belong there – which is just
the effect you’re after.
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Page 75 Dodge and Burn adjust pixel
contrast and brightness by painting them

Page 73 The Smudge tool lets you
apply paint with a finger-painting effect

Page 79 Focus in on an object within an
image by Burning the background

Page 70 The Blur tool works by blurring
the pixels in an image, to varying intensity 

Page 71 Decreasing the brush spacing
allows for a more intense Blur effect

Page 72 Maximise the usefulness of the
Sharpen tool, with its blending modes



The ‘focus’tools

The ‘focus’tools are simple to use when you
understand how they work.Let’s explore them 
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Pop-up palette
You can also pop up the
brushes preset palette 
by right-clicking in the
image window. Mac
users will need to hold
down [Ctrl] and click.

In a hurry?
The pop-up Brushes
palette can be
momentary ([Alt]+
click+hold) or persistent
([Alt]+click+release)
enabling you to choose 
a brush quickly or
browse at leisure.

The tool applies the effect continually
so even if you stop moving the mouse

the effect continues to be applied.The
strength slider therefore does not control the
maximum amount of blur, but rather the rate
at which blurring will intensify. On the right
the blur tool is applied for 5 seconds at 10%,
and on the left 5 seconds at 100%.

4

The Strength slider in the Options bar
controls the intensity of the blur – how

quickly the blur intensifies as you paint. Use
the numeric keypad to quickly type in the
strength you require. For example, pressing
the 1 key on the keypad equals 10% strength,
5 equals 50%, and 0 equals 100%. Here’s the
same stroke applied once at 10%, 50% and
100% strength to the pattern’s bottom edge.

3

The tool uses the normal brushes
interface and preset menu, accessible

from the Options bar as usual. Most of the
time you’ll be using the Blur tool with just a
normal, round, soft brush rather than 
anything fancy.

2

The Blur tool can be selected from the
seventh row of the toolbar or with the a

shortcut key [R]. Simply put, you can use this
tool to soften edges and detail in an image by
painting over it.

1



The Blur tool 

71ADOBE PHOTOSHOP TOOL TECHNIQUES – FOCUS GUIDE

Effects Tools

Blurred or
focused? 

The trick for a
successful blurring

effect, as on the girl’s
portrait, is to apply

the blur tool only to
parts of an image and

leave key areas, such
as the eye, in focus.

Blurred light 
Other blending modes
on offer – Hue, Colour

and Saturation, are less
suitable modes to use

with the Blur tool in
most cases.

But Lightness can be
quite handy, as it blurs

the details but not 
the colours.

Setting it to Lighten mode does the
opposite and creates a light glow or

halo.This is a great way to soften bright
highlights within an image in order to create
soft focus and bloom effects on otherwise
dead sharp images.

8

The tools can be set to different
blending modes, and this can be very

useful for certain effects. In Darken mode,
blurring parts of an image creates an eerie
dark glow around objects.The result is
actually similar to some types of old 
cinematic film.

7

There is however a simple way to
overcome this and to boost the Blur

tool’s power. What you need to do is edit the
Spacing setting for the brush you are using.
The default 25% spacing is often not enough.
Reducing the Spacing means the ‘flow’ of the
effect in increased, so blurring is given a boost.

6

Even with the tool set to 100% strength
it can seem like it doesn’t blur to a very

high degree. In fact it feels like it reaches a
plateau where it no longer has any effect.This
is because as the pixels get more blurry you
need an ever stronger blur to see any effect.
But since the strength is at maximum, the tool
just appears to come to a halt.

5



The Sharpen tool

The antithesis of the Blur tool is the Sharpen
tool. No prizes for guessing what this tool does
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A sharp escape
When working on large
images with large
brushes, the Blur and
Sharpen tools can take
some time to calculate.
If you want to stop the
calculation of a blur or
sharpen while in
progress, press 
the [Esc] key.

Slick selection
Selecting the general
area before using the
Blur or Sharpen tool
can speed things up.

To reduce the multicolour noise effect,
switching to the tool’s blending mode,

to Luminosity, is a great help. Now only the
brightness details in the image are sharpened
but not the colour, which is often where the 
noise resides.

4

The Sharpen tool works best when the
Strength slider is kept low – on

photographic images, or those that have been
compressed using lossy compression such as
JPEG, the sharpening can increase ‘noise’ –
the pixels become too sharp and stand out
too much from the image.Therefore, too high
a strength setting for the sharpening effect
can ruin the image.

3

You could of course construct a mask to
protect the blurred areas, but using the

Sharpen tool with a large soft brush it’s simply
a matter of painting in where you want the
sharpening to occur. Noise in blurred parts is
therefore kept at bay.

2

The Sharpen tool is used to selectively
sharpen pixels in an image.This can be

very useful, as in this image, where there is
variable focus. Applying the Sharpen filter can
sharpen unwanted noise in the blurred parts
of the image.

1



In the focus tool group you’ll also
find the Smudge tool. Its

inclusion in this group is a slightly
moot point because it has more in
common with the Paintbush, at least
in the way it’s used. A look at the
Smudge tool’s options in the Options
bar at the top of the Photoshop
interface reveals its various
properties. There is the usual
Brushes Presets drop-down menu,
where you can select any of
Photoshop’s brushes, the Blending
mode menu, Strength slider,
Multiple Layers option, and the

Finger Painting mode, which smears
the foreground colour onto the
image, using the other pixels. 

The Smudge tool

The Smudge tool is more like a spacial
paintbrush than a focus effect – here’s why 
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In Finger Painting mode, the foreground colour
is mixed with the original image pixels, while in
Normal mode only the image pixels are used

Activate with R
The [R] key activates
the uppermost tools

in the focus tool
group. [Shift]+[R]

cycles through the
Blur, Sharpen and

Smudge tools.

Smudge it
Use the Smudge tool in

the same way as you
would your finger when

working with pencil or
charcoal. Smudging a

textured brush will
smooth it out.

IN NORMAL mode the Smudge tool smears the pixels along the

direction of the brush stroke.The Strength slider is important here.

Setting it low causes the smudge effect to fade out as you brush.You can

set the strength from 1% to 99%, but setting it to 100% enables a special

mode – the first pixels you click on are sampled and smeared indefinitely,

for as long as you paint.

ALL LAYERS lets you smudge colours from all layers. However, the

results is only applied to the currently active layer, not to all the layers.

It only means that the Smudge tool samples from all the layers.

THE SMUDGE tool can take a lot of computation, especially for large

brushes. If your computer is grinding to a halt, try reducing the brush size.

MAKING USE of the blending modes can be a lot of fun. For example,

Lighten mode can create glowing swirls and streaks on an image.

THE SMUDGE TOOL’S OPTIONS IN DETAIL



Working with the Smudge tool

Here’s how to use the Smudge tool to create
some amazingly eye-catching effects
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Smudge control
The Smudge tool’s
dynamic settings can
be set up to respond
to a graphics pen’s
pressure and/or tilt
for extra response
and feedback.

New layer
The Smudge tool has a
Use All Layers option.
You can use this to
smudge pixels on all
visible layers. It’s best to
do this on a new clean
layer so you can undo
the effect easily 
if necessary.

Setting the Fade control on the Other
Dynamics section to alter the Strength

property creates a brush that gently fades the
strength, so that it’s 100% to begin with and
1% at the end.The Fade value represents the
distance over which the effect is faded.

4

What can be useful is editing the
current brush to enable the Fade

setting. Clicking on the button at the far right
of the Options bar opens the Brushes palette.
In the Shape Dynamics section the Size
control can be set to Fade and a value for the
distance in pixels entered.This creates a
tapering smudge, useful for creating wisps
and curls.

3

The Strength slider controls the length
of the smudge effect. A low Strength

setting smudges only slightly, but it will
continue for as long as you keep the mouse
button pressed.

2

Using the Smudge tool is pretty
intuitive. Set to a very high strength,

90% here, the tool continually samples colours
from the image you are smudging, dragging
the colours with it as it goes.

1



Dodge and Burn

The Dodge and Burn tools enable you to add
subtle or intense shading to an image
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Burn your own
material

Use the Burn tool to
add shadows to objects
you create from scratch
in Photoshop – such as

when creating photo-
realistic images 

and graphics.

Dodge the issue
Use the Dodge tool to

add Highlights to
objects that you have
created from scratch

in Photoshop.

With the Dodge tool set to Midtones
mode only the middle range of tones is

affected.The brightest and darkest pixels are
unaltered.You can see that a lot of
otherwise invisible detail has been
revealed.

4

In Highlight mode the Dodge tool
lightened only the brightest pixels in

the image. With an image that has strong
contrast such as this it’s easy to overexpose
the highlights and blow them out.

3

Both the Dodge and Burn tools operate
in three modes, which can be selected

from the Options bar.These are the Highlights,
Midtones and Shadows modes. By default the
Dodge tool operates in Highlights mode, and
the Burn tool in Shadows mode. We’ll
demonstrate the differences, but first here is
the original image before the exposure tools
are used.

2

The Dodge and Burn tools are two sides
of the same coin and refer to traditional

photographic techniques.The Dodge tool is
used to lighten pixels in an image, while the
Burn tool darkens them. Here are two strokes
to illustrate each tool.The image has been
Dodged on the left, Burned on the right.

1



Dodge and Burn continued
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To the extreme 
Both the Dodge and
Burn tools don’t seem
to work well when
affecting the opposite
ends of the tonal
spectrum.There are
situations where this
can be useful, but
they tend to be used
very subtly.

Background
elements
Focusing in on a subject
by dampening the
highlights of
background elements
using the Burn tool is a
good example of the 
tip above.

There’s something familiar about this
one. In Highlights mode, the Burn tool

lowers the brightness of the brightest pixels,
resulting in what looks like a stroke of
transparent black paint across the image.
So the Burn tool works best in Shadows and
Midtones mode and the Dodge tool works
best in Highlights and Midtones mode.

8

In Midtones mode the middle range of
tones is darkened leaving the darkest

and lightest pixels as they were.This is like
applying the gamma slider in the Levels
dialog to darken an image’s midtones, but
only where you paint.

7

If we start with a very light image and
use the Burn tool we can better see its

effects. Here in Shadows mode, the tool picks
out the dark areas in the image and makes
them even darker.

6

In Shadows mode, it’s the darkest pixels
that get lightened. this is quite a

different result. it looks like we’ve painted
across the image with a transparent white
brush – not good at all.

5



The Sponge tool

The Sponge tool is the cousin of Dodge and
Burn. It varies the saturation level in an image

77ADOBE PHOTOSHOP TOOL TECHNIQUES – FOCUS GUIDE

Effects Tools

Spray the sponge
The Sponge tool has

an Airbrush mode.
You can click and

hold to continually
apply the effect.

Colour Range
Make a selection using 

Color Range to focus
the Sponge tool on

certain colours in 
the image.

A better way to go about this is to apply
Hue/Saturation to the whole image

before you desaturate it with the Sponge.This
lets you see how much saturation to apply,
rather than flatten out the colours.You can
even control the saturation of the colours
independently using the pop-up menu.

4

Switching to Saturate mode, you’d think
it would be easy to increase the

saturation of the girl to enhance the effect.
However as you can see even when we lower
the strength setting, the result is uneven, and
in some places the colours have ‘flattened’ out
due to over-saturation.

3

You can of course perform this kind of
action using the Hue/Saturation

command or an Adjustment Layer. But the
Sponge tool does the same thing in a more
hands-on way. Here, we’ve painted on the
image with the Sponge tool in Desaturate
mode to make the girl stand out from the
background more.

2

Using the Sponge tool couldn’t be
easier. It’s a very simple tool that makes

pixels either less or more Saturated. By
saturation, we mean how colourful a pixel is.
More saturated colours are vivid, while less
saturated ones are washed out.

1



Using the Dodge and Burn
tools is quite simple but you

need to take into account certain
things, in order to get the best
results. The Dodge and Burn tools
are often used to add shading to
elements in a composite image so
that they match the background or
other elements in the image.

Look for shadows in the image to
find out where the main light is
coming from. Highlights – parts of
the object in direct illumination –
can be added by painting with the
Dodge tool in Highlight and/or

Midtones mode, while shadows can
be painted on with the Burn tool in
Shadows and/or Midtones mode.

Using Dodge and Burn

Here’s how the Dodge and Burn tools work
in real, or surreal, situations
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The direction of the light cast on other elements
or in the background image, determines where
to apply effects with the Dodge and Burn tools

Toggle tools
Use the [Alt] key to
toggle between the
Dodge and Burn tools
as you work.There’s no
need to stop and switch
tools manually.

The Options bar is where
you’ll find the different
modes and the strength
slider for the exposure tools.

Airbrush mode is available
for the Dodge, Burn and
Sponge tools. This applies the
effect constantly while the
mouse is held down, so
there’s no need to wiggle the
mouse to intensify the effect
in a certain spot.

These areas in the image
have been darkened by
painting on the image using
the Burn tool, and setting it to
Shadows mode.

The Sponge tool has been
used in many of the dodged
and burned areas to
desaturate the image in
those places.

Dodge, Burn and Sponge
tools are located in the
‘exposure’ tool group in
Photoshop 7’s toolbar.

These areas in the image
have been lightened by
painting using the Dodge
tool in Highlights mode.

THE EFFECTS OF DODGE, BURN AND SPONGE



Focusing in with Dodge and Burn

Dodge and Burn is a great way of focusing in
on the subject of an image, or even a new area
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Faded paint
After using the
Dodge, Burn or

Sponge tools, you can
used the Edit > Fade

command to vary the
intensity of the last
stroke you painted.

Fade away
The Fade command
actually works with

most of the brush-
based tools in

Photoshop.You can
often change the

blending mode here
as well as the opacity.

Using Shadows mode is probably not 
a good idea in this case because you

would be changing the contrast balance
between the subject and background in a
more unnatural way.

4

We can work on the background layer,
(having made a copy of it) with the layer

mask applied to protect the main leaf. We’ll
use the the Burn tool set to Highlight mode
and a low opacity. Keeping the brush strokes
loose and slightly random, we can dampen
the brightness of the surrounding leaves.

3

We can force the image to have a
subject by picking one of the leaves and

then adjusting the rest using Dodge and Burn.
First we isolate the subject leaf by creating a
mask for it using the Magnetic Lasso and then
Quick Mask mode to touch up the edges.

2

Here’s a good example of an image that
has no focus. It would work well as a

texture or background, but the uniformity of
the subject makes it difficult to pick out any
one leaf as the main subject in the image.

1



Chapter 7

WORKING WITH
THE TYPE TOOL
IN PHOTOSHOP

Type and text has numerous
applications in Photoshop. 

You can create logos, web buttons,
cool 3D text, even paragraphs of
prose using the Type tool. In earlier
versions of the program, text was a
very basic affair. You created text as
a selection which could be filled
with a colour in a layer or applied as
a layer mask to create type that
knocked out part of an image, or was
itself filled with an image or texture.

In Photoshop 7, text has become a
fully-fledged feature, and the most
important aspects of this are its Type
Layers. Like Adjustment Layers,
Solid Fill and Gradient Layers, Type
Layers are ‘live’. This means that the

In this chapter…

U s i n g  t h e  Ty p e  t o o l
a n d  Ty p e l a y e r s

C r e a t i n g  t y p e  e f f e c t s
w i t h  L a y e r  S t y l e s

Managing, transforming
and distorting type

Creating text in Photoshop is quite easy to do,
whether it’s for artistic effect or simply to add
essential information.We’ll look at the various
options available with the Type tool

text is created as real type just like in
a word processing program or vector
illustration program. The type can be
edited, so that you can go back and
change the font used, the colour
applied or the properties of the text,
such as scale, leading (line spacing)
and kerning (letter spacing).

Quality assured
Type layers are produced using
vector technology, just like in a
vector-based tools such as Illustrator
or Freehand, and this has two very
important consequences. The first is
that type is ‘resolution independent’.
This means that you can scale,
rotate, stretch and distort type layers



and they will never degrade. It is the
vector paths that are altered, and the
rasterization is performed at the end.
You’ll always have crisp, clean type,
until the Photoshop document is
saved as a flattened image or printed.

Pixel perfect
The other consequence is that you
can, if you wish, decide to keep the
text as vectors if you print to a
postscript printer. This means that
the type is printed at the highest
possible quality and is never
converted to pixels. Even perfectly
rasterized type will print slightly
fuzzy at the edges. This is because
of the necessary anti-aliasing that is

used in order to convert the flowing
lines of the vector paths into the
rows of square, coloured pixels in a
normal image layer. To be honest,
printing type as true vectors is only
important when producing the
highest quality artwork for printing
on professional printers. Because of
this it only works when out-putting
CMYK separations from Photoshop.

Note: Rasterization is the process of
converting vectors and paths into
‘raster’ images, made up of pixels.
Once a type layer is rasterized it
loses any of its special editable
properties and becomes just an
ordinary pixel-based layer.
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Page 87 The Warp Text palette lets 
you distort your type any way you like

Page 84 Learn how to distort vector
text in later versions of Photoshop

Page 89 Use Layer Styles with live layers
to create rich and varied text effects

Page 82 Older versions created text as
selections. Photoshop 7 is more flexible

Page 83 Type layers in Photoshop 6
and above can be edited at any time

Page 84 Get to grips with the idea of
different kinds of anti-aliasing for text



The Type tool

Photoshop’s Type tool allows you to add
impressive text and type effects to any image
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Twice the size
If using an older version
of Photoshop without
vector text and you
need to transform 
type, do so in a new
document that is 
twice the size of the
destination document.
The higher resolution
will minimise the
degradation of the 
text edges. Resize 
the image once the
transformation 
is completed,
sharpening it 
as necessary.

Computer Arts 
To discover even more
ways to develop your
Photoshop skills, check
out our sister magazine,
Computer Arts.
www.computerarts.co.uk

Furthermore, if you wanted to edit the
mask, to make it smaller or larger, distort

it and so on, then the quality of the edge
pixels will deteriorate even further. After just a
few transformations the edges become fuzzy.

4

While this is fine, the text is not a vector
object, so the edges of the type are not

always as crisp and clean as they could be.
This is due to the anti-aliasing used to smooth
non-straight edges of pixel-based images.

3

The type selection could be filled with a
flat colour, saved to a channel ready for

some channel effects work, or as here applied
to an image layer, to create image-filled text.

2

Previously, in releases of Photoshop
earlier than version 6, text was created

like this, as a selection.You could type in your
text in a panel, choose the font and other
options but once created, that was it.

1

http://www.computerarts.co.uk
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Vectors and rasters
Though the type layers

are vector-based, just
like any vector program

Photoshop has to
rasterize them in order

to display them. But
this is an ongoing

process.The type itself
is still stored internally

as a vector.

Rescaling
with text

If you were to rescale a
document containing a
live Type Layer, the type

would scale up 
correctly along with the

pixel layers, but 
would not suffer 

any degradation.
Even after many transformations, the
type layer’s edges remain as crisp and

properly anti-aliased, as it was when the type
was first created.You don’t have to worry
about the edge degrading when working with
type layers.

8

Type created like this is ‘live’.You can
select the layer and make changes to

the text it contains, change the font, colour
and whatever else you like.Transforming this
layer is possible using the Free Transform tool,
just as if it was a normal pixel layer.

7

The Type Masks are just like those in
older versions of Photoshop, except

they are more easily edited while they are
being created. Afterwards they are not
editable.The normal Type tool creates type 
as a special vector layer called a Type Layer.

6

The vector text introduced in
Photoshop 6 is a whole different ball

game.The Text tool, located in the eighth row
of the toolbar, contains four different tools.
Horizontal and Vertical Type, and Horizontal
and Vertical Type Masks.

5



The familiar Options bar in
Photoshop 7 is home to the

Type tool’s Options and Properties.
As with all tools the first entry at the
top-left is the tool preset picker 
pop-up, from which you can select
preset tool settings, or reset the tool
to default. Next is the Horizontal/
Vertical Type toggle, followed by the
Font drop-down menu, Font Style
and Font Size drop-downs.

The next menu is the Anti-aliasing
control. This is an interesting feature
because it enables you to change the
edge anti-aliasing of your text on the

fly. The options are None, Sharp,
Crisp, Strong and Smooth and range
from sharpest to smoothest.

Type Options

The Type tool’s Options bar is one of 
the most feature-packed in Photoshop
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The Type Anti-aliasing feature controls how
smooth the edges of your type is. It’s more 
noticeable on small type that on larger type.

Cycling fonts
The Font field can be
scrolled through to view
alternative fonts, just like the
Font Size field. Just place
your cursor in it and using
the Up/Down arrow keys.

Choose the typeface you
want to use for the selected
type from the Font menu.

Choose your paragraph
alignment by clicking on the
buttons in the Option bar or
in the paragraph panel.

A text layer is denoted by a
large letter T in the layer
preview. The layer name is
always the first few
characters of the text.

The Character panel
contains many of the
properties found in the
Options bar plus some 
extra ones, such as Kerning,
Leading and Scale.

Text can be warped using
the Warp Text panel. This is
useful for creating many
special text effects.

Selected text is highlighted
in black. The text colour is
inverted when selected,
so this type will be black
when deselected.

A WHISTLE-STOP TOUR OF YOUR TYPE TOOL OPTIONS



Type tool tips

Some practical tips and advice for getting 
the most out of Photoshop’s Type tool
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Quick resizing
You can increase or
decrease the size of

text by placing your
cursor in the Size field
and using the Up and

Down arrows.
[Shift]+Up/Down

moves the values in 
larger chunks.

Specify units
You can specify text size
using any units you like.

Just place your 
chosen unit after the 

number value.
For example, 20cm is

the same as 
2362.2 pixels.

To set the kerning for your text, open
the Character palette by clicking the

palette icon in the Type tool’s Options.There’s
a letter spacing pop-up menu, where you can
choose your desired value. Negative numbers
offer tighter spacing.

4

When creating headings and other
large type, there is a simple rule that

you can apply to get better results. Basically,
larger text such as headings – especially
chunky bold fonts – can have much tighter
kerning (letter spacing) than normal text.
Here’s the same word, one with much tighter
letter spacing.

3

You’ll notice that the drop-down list
only goes up to 72-point text.This is fine

for most web page titles and such, but not
nearly big enough for images destined for
print. If you want larger text, then you have to
enter a value in the text field manually. Here
we’ve used 500-point text in a 1000x1000-
pixel image.

2

When you create text in a Type Layer,
one of the main things you’ll want to do

is get the text the right size.There are, as
always, different ways to do this in Photoshop.
The most obvious is the Size menu in the
Options Bar. Open it up and choose a size.

1



Type tool tips continued
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Speedy selections
Select text by clicking
on it with the Text
tool. Alternatively you
can select a type layer
and the text within it
by double-clicking the
Layer Preview icon.

Type tool options
The Type tool’s
shortcut is, surprise
surprise, the [T] key.
You can cycle through
each tool in the tool
ground by typing
[Shift]+[T].

Attempting to pan an image while text
is selected will result in this. All your text

will be replaced by a space. If this happens just
click the Cancel Current Edits button in the
Option bar to retrieve your previous text as it
appeared before you started editing it.

8

The only safe way to navigate your
document when in editing mode is to

use the View menu or the [Ctrl]+[+/–] shortcut
(that’s [Command]+[+/–] on a Mac). At least
then you are able to zoom in and out of the
image while text is selected.

7

However, when you move your cursor
far enough away from the text it turns

into the Move tool automatically.This at least
gives you the option to move text around
without leaving the text editing mode.

6

Selecting text can be tricky, but once
you get the hang of it you’ll be fine.

Once text has been created you can click on
the tick in the Options bar to return to normal
Photoshop operation. While text is selected
most of the key commands no longer work,
so be careful you don’t accidentally add
unwanted characters.

5



Using the Warp Text panel
Photoshop won’t let you warp text along 
a path, but there are still plenty of Warp options 
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Be patient
Because Type Layers are

vectors the distortion
does not degrade the

quality of the type.
However, large

amounts of text will
take longer to distort

than a single character.

Extra text tools
Photoshop has

Paragraph tools as well
as Character tools.

These can be found in
the Paragraph palette,

which is docked with
the Character palette

by default.
Using nonsense fonts or symbols
together with the Warp panel you can

get some weird shapes and patterns. It can be
fun and – like all the best features – it takes
some playing with.

4

Warps can be subtle or pretty severe,
depending how you set the sliders.

The Horizontal and Vertical sliders control a
kind of perspective distortion of the type
layer, making it appear to tilt towards or away
from you on either axis.

3

There is a Style pop-up menu, from
which you can choose numerous

distortion types.This is a simple Arc Warp,
set to Vertical mode.

2

When you select a ‘live’ type layer,
you can access the Warp Text panel by

clicking its icon on the Options bar.The panel
opens and allows you to distort the selected
type using some simple controls.

1



Because type layers are vector-
based you cannot apply pixel-

based effects to them. So you can’t
use filters or paint on them directly,
and you can’t apply adjustments to
them to change their colour or
brightness. You can get around these
problems by adding an adjustment
layer above your type layer, but
you’ll also need a mask if you only
want the adjustment applied to the
text and not to the layers below.

You can change the blending
modes of type layers, which results 
in some interesting type effects,

especially over image layers. But 
to really get stuck into text layers 
you’ll need to rasterize them.

Rasterizing type

In order to apply normal Photoshop effects 
to type, you’ll need to rasterize it first
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Flatten it
All non-pixel layers
can be rasterized in
Photoshop, using the
appropriate
commands in the 
Layers menu.

One way to rasterize type
is to Choose the Layer >
Rasterize > Type command
from the main menu.

Another method is to load
the type layer as a selection.
[Ctrl/Command]+click on the
layer icon and create a new
layer. Fill this layer with colour
using the type selection.

You can apply Layer Styles
to live type layers. In this case
there’s no need to rasterize
them beforehand.

To rasterize a type layer,
right-click on the layer’s
name in the Layer Palette
and choose Rasterize Layer.

If you want to keep the
type layer editable, you can
make a copy of the layer by
dragging it onto the New
Layer icon at the bottom of
the Layers palette.

If you try to do something
that requires the type layer to
be rasterized, Photoshop may
ask you if you wish to do this
first in a warning dialog.

RASTERIZING YOUR TYPE LAYERS

Rasterized type layers act like bitmap layers,
because that’s just what they are. This type has
been rasterized, blurred and adjusted with levels.



Styled Type

Layer Styles can be used to create 
stunning type effects for any occasion
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Quick colour
change

The Colour Overlay
section of the Layer

Styles palette can be
used to quickly change

the colour of your text
without changing 

to the Type tool 
and selecting it.

Save your Styles
Custom Styles can be
saved as presets and

stored for reuse by
clicking the 

New Style button in the
Layer Styles palette.

Text can be ‘stroked’ using the Stroke
section of the Layer Styles.The Stroke

function adds an outline to the text, which can
be useful if you have filled it with a pattern
because the text is more clearly defined.

4

The Pattern option lets you fill the text
with any saved pattern. In this case

we’ve used an American flag that we had
previously saved as a pattern to fill our 
New York text.

3

To create text with a bit of relief you can
use the Bevel and Emboss options to

add depth to your text. It helps if the text is
not set to 100% white or black, because the
Bevel and Emboss effects add black and white
shading to create the illusion of depth.

2

With a type layer selected in the Layers
palette you can select Layers > Layer

Styles and choose an option from the 
sub-menu to apply that style to the text.
In this case a simple drop-shadow has been
applied.The Layer Styles panel will
automatically pop open.

1



Chapter 8

WORKING WITH
PATHS,VECTORS
AND MASKS

Vectors are totally different
from pixels: vectors are

mathematically defined lines and
curves, which you can use to draw
perfectly smooth shapes and
outlines. Whereas a shape made up
of pixels has a definite size and
resolution, vectors can be of any size
or resolution – they are said to
‘resolution independent’.

Furthermore a vector-based image
will be a very small file when saved
to disk, compared to a pixel-based
bitmap image. The same file could
be used to make a 128x128 pixel
web graphic, or a 5000x5000 pixel
poster. The quality will be perfect in
both situations.

In this chapter…

L e a r n  h o w  t o  u s e  t h e
P e n  t o o l  t o  d r a w  p a t h s

L e a r n  h o w  t o  c u t  o u t
o b j e c t s  u s i n g  p a t h s
a n d  c o n v e r t  t h e m  t o
s e l e c t i o n s , a n d  
v i c e - v e r s a

Work with Vec tor Masks
t o  a d d  a d d i t i o n a l
l a y e r i n g  c a p a b i l i t i e s
t o  y o u r  d o c u m e n t s

L e a r n  t o  u s e  Ve c t o r
S h a p e s  a n d  i m p o r t e d  
v e c t o r  a r t w o r k

Photoshop has always used vector-based
‘paths’ to draw smooth shapes and outlines,
but the latest version has the ability to create
shapes and masks with vectors too

Photoshop has limited capabilities
when it comes to saving vector-only
files but you can include vector
information in a normal Photoshop
file. While this means file sizes
won’t be quite as small as they
would be with a true vector-based
program, you will still get all the
advantages of a vector’s scalability.

Various vectors
In Photoshop, vectors come in
different varieties: first, there’s the
Pen tool, which is used to create
‘Paths’ (Photoshop’s traditional
name for vectors) but there are also
Vector Shapes; these are a new
feature that appears in later versions



of Photoshop which you can use in
their own special layers, instead of
relegating them to the Paths palette.

Paths were an alternative method
for creating selections in Photoshop,
since a path can be loaded as a
selection once it’s been drawn. This
makes them ideal for cutting out
complicated shapes, such as when
you’re removing an object from its
background – useful when the
background is complex and it has
become difficult to select using the
selection tools.

Paths can also be ‘stroked’,
making them an alternative painting
tool. Stroking a path with a brush is
a fun way of turning plain vector

shapes and imported artwork into
complex painted graphics with the
richness of pixel-based brushes.

Shape your behaviour
Vector shapes behave like layer
masks, blocking and revealing parts
of the layer to which they are
applied. You can edit them with the
Pen tool or the Direct Selection tool,
and they offer a further level of
functionality for the program.

Photoshop is not a fully-fledged
vector-drawing application such as
Illustrator, Freehand or Corel Draw,
and probably never will be, but there
is surprisingly good support for
vector drawing in Photoshop.
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Page 92 Learn how to use paths and
work with the Paths palette

Page 97 Set overlapping vector shapes
to different Boolean modes

Page 95 Add Shape Layers to the layer
stack when you create a vector shape

Page 99 Apply Layer Styles directly 
to Shape Layers

Page 93 Use the Freestyle Pen tool to
sketch paths

Page 94 Use the Convert tool to alter
the control points



Using the Pen tools

You can use the tools in the Pen family 
to draw all kinds of paths
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Control points
Each time you click
with the Pen tool, a
control point is added.
Always try to use as
few control points as
you can, because it
makes the path much
easier to control.

Path options
The Paths palette has
an Options menu,
where you can choose
the size of the display
icon, or choose to
turn it off.

You can combine smooth and sharp
control points in a path to make it both

smooth and angular – simply click without
dragging to place a sharp control point where
you need one.

4

Clicking and dragging pulls out the
Bézier handles from a control point,

turning it into a smooth point.You can use
smooth points to create curved paths, such as
this roughly circular path.

3

The Pen toolgroup contains five
separate tools.The first is the ‘normal’

Pen tool. Use this to draw smooth or angular
paths by clicking in the document; clicking
without dragging creates a sharp control
point used to make angular paths, such as this
quadrilateral shape.

2

The Pen tool is located in the ninth row
of Photoshop’s toolbar – it’s easy to find

because it looks just like its name. In older
versions of Photoshop the only place you
could create paths was in the Paths palette.
All the paths you drew would be located here.

1
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Add anchor points
When using the Pen

tool, the cursor will
automatically change

to the Add Anchor
Point tool whenever

it’s over part of the
path. Just click on it to

add a point.

Quick curves
You can edit the curve

between two points
directly by clicking and

dragging it.The
handles of the two

adjacent points change
simultaneously, but do

not change 
their location.

Next is the Add Anchor Point tool.This
tool enables you to add control/anchor

points in between existing points on a path.
The path will not change shape when you add
a point using this tool.

8

The second tool in the Pen toolgroup is
the Freeform Pen tool. With this tool you

can literally draw a path, as opposed to
clicking to place point.Your freehand sketch
will be converted to a path consisting of as
few control points as possible.

7

A Path layer in the Paths palette can
contain more than one separate path

entity. Once you’re finished drawing a path,
[Ctrl]+click to end the Pen drawing action so
you can start a new path. Mac users should
[Command]+click instead.

6

Paths can be open or closed. An open
path does not loop back on itself,

whereas a closed path does.To close a path,
you position the cursor over the starting
control point and the Pen cursor will change
to show a small ‘o’ next to its pointer. When
you click, the ends of the path will join up.

5



Using the Pen tools continued
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Load a path
To load a path as a
selection, [Ctrl]+click
on the path icon in
the Paths palette
(that’s [Command]+
click for Mac users), or
click the ‘Load path as
Selection’ button at
the bottom of 
the palette.

Convert a
selection
You can convert a
selection into a path
by clicking the ‘Make
Work Path from
Selection’ button in
the Paths palette.

Holding down the [Ctrl] key when any
of the Pen tools are selected activates

the Direct Selection tool (Mac users should
hold down the [Command] key).This is the
prime editing tool for Paths. Use this tool if
you want to move Bézier handles together
without breaking them.

12

You can also use the Convert point tool
to edit the Bézier handles of a smooth

point.When you do this with this tool the
Handles will ‘break’ – that is, they will move
independently of each other.

11

The final tool is the Convert Anchor
Point tool.This is used to change a

sharp point into a smooth one, and vice-versa.
To use it, click on a smooth point to convert it
into a sharp point (or ‘cusp’); drag on a point 
to convert a sharp point into a smooth one.

10

The fourth tool is the Delete Anchor
Point tool.This tool does the opposite 

of the Add Anchor Point tool: clicking on an
existing point on the path with this tool will
delete it.You might find that the path will
change shape as a result.

9



Next to the Pen tool in the ninth
row of the tool bar is the

Vector Shape tool. This enables you
do draw shapes as vector paths or
vector masks by dragging them out
in the Layers or Paths palette.

With the tool selected you can
choose from the Options bar what
you want to create. You can select
the Pen and Freestyle Pen tool from
the Vector Shape tool’s Options, but
there are also the specific shapes:
Ellipse, Rectangle, Rounded
Rectangle, Polygon and Line.

A third option is the Custom

Shape, which enables you to choose
a shape from the library of designs
that ships with Photoshop.

Vector Shapes

Vector Shapes are new to later versions of
Photoshop – here’s what they do
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A Vector Shape can be created as a mask for a
solid fill layer, and optionally, as here, have a
layer style automatically applied to it.

Preset styles
If you choose a Layer
Style preset from the

Layer Styles preset
pop-up before you

drag out a shape, that
style will be applied to

the shape.

The Custom Shape option
in the Vector Shape’s Option
bar gains you access to a
large library of custom 
vector designs.

This is a Shape Layer: it is
essentially a solid fill layer
with a vector mask.

Layer Styles can be applied
to Shape Layers; here a drop
shadow is applied.

Photoshop comes with a
large collection of custom
vector shapes.

Your shape can be created
in three ways: as a Shape
layer, as a plain vector path
in the Paths palette, or as a
direct pixel fill with no saved
vector attributes.

Whenever vector shapes
overlap in the same layer, you
can choose how they will
react to one another. The
options are: Add, Subtract,
Intersect and Exclude.

HOW TO CREATE CUSTOM SHAPES



Using Vector Shapes

Using the Vector Shape tool in versions of
Photoshop that support vector shape layers
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Arrowheads
Arrowheads can be
found in the small pop-
up menu next to the
Custom Shape button
in the Options bar.

Line width options
In Line mode, you can
change the line width
by entering a value in
points in the Options
bar. Hold down the
[Shift] key when
drawing lines to
constrain them to 
45-degree angles.

The fourth option is to do away with
any vector information and create the

shape as pixels on a normal layer. Using the
Line Shape option, this is the only way to
simulate the Line tool function in older
version of Photoshop.

4

The second option is to create the
shape as a simple path in the Paths

palette.You do not need to be in the Paths
palette to do this, just click and drag in a layer
– the vector shape is created in the Paths
palette automatically.

3

This creates a Solid Fill Layer and adds
the path as a vector mask to the layer.

Layers in Photoshop 6 and onwards can have
two masks per layer: a vector mask and a
normal layer mask. Here a gradient mask is
used on the layer as well.

2

When you select the Vector Shape tool,
you have three options that determine

how shapes will be applied to your document.
These options are located at the top-left of the
Options bar.The first is Shape Layer mode.

1
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Add mode
You can also add to

the current vector
mask by turning on

Add mode in the
Boolean options to

the right of the
Options bar.

Chop and change
Make complex vector

shapes by intersecting,
subtracting, adding
and excluding more

simple ones.

You can use the Boolean switches 
on existing shapes in a vector mask 

as well, just as you can for shapes that you are
about to create. Here we have changed the
mode for the third circle from Subtract to
Intersect mode.

8

In Add mode, the overlapping vector
shapes simply overlap and add

together. However, switching to Subtract
mode turns the next vector that you draw into
a ‘cutter’, which you can use to remove
portions of the current shapes.

7

In order to add a vector shape to an
existing shape layer, you must switch to

Path mode and select the Vector Mask Layer.
Now when you drag out a vector shape it is
added to the same vector mask in the
currently selected vector layer.

6

When set to Layer Shape mode,
dragging out additional vector shapes

creates new vector shape layers, which is not
always what you want to happen, and also
precludes the use of the vector shape Boolean
interaction options.

5



Photoshop has more masks than
you might realise. There is an

additional mask in each layer
(besides the background layer, which
is always 100% opaque) that you
don’t usually see. This is because 
it’s the layer itself, or rather the
surrounding transparent pixels. 

If you paint on a transparent layer,
the brush stroke is surrounded by
transparent pixels. The pixels in the
layer are a mask in their own right.
This can be proved because you can
load it as a selection by [Ctrl/
Command]+clicking the layer icon.

You can also group layers together
into a ‘clipping group’ by [Alt]+
clicking between them on the
separator in the Layers palette – the
cursors will change to overlapping
circles indicating clipping group
mode, and clicking will cause the
uppermost layer to be indented. 
The layer will be masked using the
bottom layer’s Layer Transparency
Mask, and its Layer Mask and its
Vector Mask, if these are present.
This enables you to quickly mask
multiple layers using a single layer
or vector mask, and is very useful.

Masks

A bit of detail about masking to help you get
the most out of vector layers and masks
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Layer Folders
A Layer Folder (aka
‘Layer Set’) can
actually hold two
masks: a normal layer
mask and a vector
mask, giving you
potential access to
four different masks.

Photoshop 6 introduced a new kind of layer mask: the Vector

Mask. This uses a vector shape to make portions of a layer

transparent and works in tandem with the normal layer

mask. Vector masks are either on or off: they either hide or

show the layer 100%; there is no in-between value like with

normal layer masks, which use 255 grayscale values. But what

happens if you already have a layer mask and a vector mask

on a layer but would really like a third? You can do this

through the use of layer folders. Adding a layer folder and

placing your layer inside it gives you access to two further

masks that can be applied to the folder layer itself.

VECTOR MASKS AND LAYER FOLDERS

If you run out of masks you can always add a folder

A layer folder can be used to add
further masks to a layer if you find 
you need more than two 



Vector Shape details

We’ll look at some of the options that are
specific to Vector Shapes
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In a corner
You cannot change

the radii of the
corners of a rounded
rectangle after it has 

been created.

Quash confusion
Don't confuse the

Move tool with the
Path Selection tool.
The Move tool does
not have a 'tail' and

cannot be used to
move paths
individually.

The usual copying options apply with
paths as well as selections, so you can

make a copy of a shape by selecting it and
[Alt]+dragging it. Here we’ve duplicated the
arrows, and changed their mode to Add.

4

When editing the shapes you need to
select the Direct Selection tool.Then

you can drag out a marquee around the
points you wish to move. Selected points are
displayed as filled-in dots; unselected ones are
unfilled dots.

3

The Polygon shape tool is used to create
regular shapes of any number of sides.

Here a triangle is created in Subtract mode to
cut a hole in the Rectangle.

2

The Rounded rectangle shape is used to
create rectangular shapes and masks

with rounded corners. Before you drag out the
shape you can set the desired corner size in
the Options bar. Add a Layer Style if you like.

1



Chapter 9

ANNOTATIONS,
NOTES AND THE
MEASURE TOOL 

The ‘notations’ tools, Note and
Annotation, can be found in the

tenth row of the toolbar in their own
tool group. The Note tool allows you
to attach informative notes to
Photoshop documents. These can be
read by other Photoshop users when
the document is opened, so the tool
can be very useful when using
Photoshop collaboratively. It can also
be very handy for creating teaching
aids in an educational environment.

Taking this one step further is the
Annotation tool. This allows you to
add sound clips to images that can be
played by double-clicking their icon.
This again provides a useful way to
communicate with others working on

In this chapter…

A d d  N o t e s  a n d
A n n o t a t i o n s  t o  y o u r
P h o t o s h o p  d o c u m e n t s

Learn which file formats
work with Notes and
Annotations 

U s e  t h e  E y e  D r o p p e r
t o o l  t o  s a m p l e  c o l o u r s
f r o m  a n  i m a g e

S ample precise pixel
values at different
points of  an image with
the Colour S ampler 

Along with the creative tools, Photoshop
provides several tools to add accuracy, sound
and vision to your work.These fall into two tool
groups – notation and measurement tools

a project, or for producing learning
aids directly within the program.

Measure for measure
The measurement tools are very
useful utilities in Photoshop. The
Measure tool itself lets you measure
distances and angles, providing you
with precise information that you can
use in conjunction with other tools 
in Photoshop. You can measure the
distance between two points, or the
total horizontal distance covered,
plus you can snap the tool to grids
and guides when more precise
measurements are needed.

The Eye Dropper and Colour
Sampler are essential when working



professionally with colour, but are
also very useful on a day-to-day
basis for any Photoshop user. The
Eye Dropper can be accessed in
various ways in Photoshop. For
instance, when the Colour Picker is
open, if you move your cursor off the
Colour Picker panel and over the
image, the cursor automatically
changes to an Eye Dropper, enabling
you to sample the colour of any
pixel. The tool can also be toggled on
and off by holding down the [Alt]
key when a Brush tool is selected.

The Colour Sampler is like the 
Eye Dropper tool on steroids. You
can sample a maximum of four
points simultaneously and read their

values in the Info palette. This can 
be extremely useful when making
colour adjustments because the Info
palette displays the original values
both of the sampled pixels and the
adjusted values. 

Colour by numbers
The great advantage of these colour
measurement tools is that you don’t
need to rely on your eye or the
dubious colour characteristics of
your computer monitor. Instead, you
can see the exact values numerically.
This accuracy is a real bonus for
professional printing needs, but also
for achieving good results on a home
colour photo printer.
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Page 106 The Colour Sample tool puts
up to four sample points on an image

Page 105 Sampling options can read
the perceived colour from a noisy image

Page 107 Use the Measure tool to help
straighten out crooked images and scans

Page 102 Add notes to images to use
as a handy reminder later on

Page 103 Sound clips can be added to
images, with a microphone

Page 105 Choose the foreground or
backround colour with the Eye Dropper 



Notes and Annotations

Make notes and annotations, attach them to
images, and learn how to open and save them
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Name change
You can also change
the name in the title
bar by entering a new
one in the field in the
Options bar and
pressing return.

Closing notes
To close a Note click
the close box in the
top-left corner of the
Note’s title bar.The
Note will collapse to
an icon on the image.
Double-click it to
open it again.

To save a document containing a note,
you must use one of three file formats.

These are Photoshop, Photoshop PDF and
TIFF. All the other file formats will discard the
note information, as they do not support it.

4

You can have more than one note in a
document, and in order to differentiate

between them you can choose to give them
different colours.The note’s title bar and its
icon take on the new colour when collapsed.

3

There is not a lot of editing that you can
do to the note text itself, but you can

change the font and set the size.There are
only five preset sizes: Smallest, Small, Medium,
Large and Largest. Smallest and small are
practically unreadable, though.

2

Creating a note could not be easier.
With the Note tool selected you click on

the image where you want the note icon to
appear. A window, like a little Post-It note,
appears where you can enter your text.

1
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Take the mic
In order to record an

annotation you must
have a microphone

connected to your
computer’s sound
card or mic input.

Colourful sounds 
Annotations can be

coloured using the
colour swatch in the

Annotation tool’s
Options bar.You can

reuse annotations
from other documents.

You can import
annotations 

by selecting File > 
Import > Annotations.

As with notes, documents containing
annotations must be saved as either

TIFF, Photoshop PDF or plain Photoshop
format. If you don’t want to display
annotations you can hide them using the 
View > Show > Annotations menu command.

8

Because the audio annotations are a bit
difficult to see it may be wise to build

your document with spaces to accomodate
them.This is an example of a way to help
guide people to the right annotation.

7

Click on Stop to end recording.There is
no interface for the audio annotation,

you just double-click to hear the recording. If
you look hard enough you can just about see
the icon next to the Annotation tool’s cursor.

6

With the Annotation tool you can attach
a sound clip, usually a spoken sentence,

to an image in a similar way to notes. Clicking
on the image with the Annotation tool opens
a dialog prompting you to start recording.

5



The Eye Dropper tool samples the
colours of individual pixels in an

image, but there is more to it than just
being able to set a new foreground
colour. In Levels Adjustment, you can
use the Eye Dropper by moving the
cursor over the image, and reading the
tonal values at different points. To see
if the darkest shadows are really black
and the lightest really white, hover the
Eye Dropper over them and read their
values in the Info palette. The palette
can display various colour values –
CMYK, RGB, LAB and so on. With
RGB (Red, Green and Blue pixels)

the darkest pixels should read 0,0,0.
Pure white reads 255, 255, 255 – the
maximum brightness value.

The Eye Dropper tool 

The Eye Dropper is an essential Photoshop
tool, especially for achieving colour accuracy 
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Using the Eye Dropper tool while working with
the Levels adjustment panel allows you to read
the original and adjust values in the Info palette.

Eye Dropper info
You can also use the
Histogram with the
Eye Dropper to read
values and gauge the
distribution of tones
in an image.

Select a sampling method
from the Options bar. Choose
to take a point sample, or
measure the average colour
within 3x3 or 5x5 pixels.

CMYK documents are
destined for print and colour
is critical in this type of
medium. You can check what
colour mode the document is
in the title bar.

Using the Sampler you can
look at the darkest an
lightest points in an image
simultaneously.

The Info palette displays
colour values differently
depending how you have it
set up and what colour mode
your image is in.

The Colour Sampler tool
lets you place multiple
sample points in an image,
marked by ‘bull’s eyes’.

The colour values for each
point are displayed in the
Info palette.

THE COLOUR SAMPLE TOOL



Using the Eye Dropper tool

Using the Eye Dropper tool couldn’t be easier,
but it boasts a few less obvious features too
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Colour accuracy 
The 3x3 average

sample size can be
more accurate,

especially on busy
images where the

colour varies 
dramatically.

Get a colour
update 

Click and drag over
the image to see the

colour sample update
interactively in 

the toolbar.

To get around this there are two other
modes – 3x3 Average and 5x5 Average.

Each mode samples a grid of pixels around the
one you select, sums their colours and takes the
average.The sample is usually a much better
match to the colour you perceive by eye.

4

When in Point Sample mode, selected
from the Options bar drop-down menu,

it can be tricky to sample the perceived colour
of a particular area of a noisy image.The
actual pixels may vary in colour dramatically
and not represent the overall colour of the
particular area of the image.

3

To chose a new background colour,
you could flip the Foreground and

Background swatches using the [X] key, take 
a sample and flick back, or simply hold down
the [Alt] key when the Eye Dropper tool 
is selected.

2

You can choose a different foreground
colour when painting by selecting the

Eye Dropper tool from the toolbar and
clicking on the image.The tool will sample the
colour of the pixel you click in and store it in
the Foreground Colour swatch.

1



The Colour Sampler

The Colour Sampler tool enables you to take
up to four colour readings at once
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Neutral colours
RGB mode stores the
image as three colour
channels, Red, Green
and Blue. If you sample
a pixel and each of the
values for R,G and B are
the same, (say, 45,45,45
or 189,189,189) then
you know that pixel is a
neutral pure grey tone.

Colour in
confidence
Using the absolute
colour values is a sure-
fire way of proofing
certain aspects of an
image, since it avoids
the vagaries of 
your computer’s
monitor display.

Like the Eye Dropper tool, you can set
the mode for the sample points to be

either single pixels, or averaged pixels (3x3 
or 5x5 pixel arrays, around the sample point).
The latter are useful for ‘noisy’ images.To clear
all the sample points, click the Clear button in
the Option bar.

4

To delete a sample point hold the [Alt]
key down and click on the point – the

cursor turns to a pair of scissors. Alternatively
right-clicking on a sample point will open a
pop-up menu from which you can choose 
the Delete command. Mac users will need to
[Ctrl]-click for the latter function.

3

You can move sample points around
after they have been created, and they

are truly permanent. Even if you close the
document, and reopen it the sample points
will have been stored. Displaying colours in
RGB mode in the Info palette helps you gauge
the neutrality of tones in an image.

2

The Colour Sampler tool in the 
Eye Dropper tool group (tenth row of

the toolbar) can be used to place multiple
permanent sample points on an image to help
while adjusting the image’s colour.The Info
palette displays the colour reading.

1

Zinio
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The Measure tool

Taking measurements is very useful for
accurate drawings or precise transformations
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Diagonal
perfection

Hold down the [Shift]
key to constrain the

Measure tool’s angle to
45-degree increments.

This is useful when you
want to measure a

perfect diagonal.

Auto
measurements

With the Free
Transform tool,

the value will
automatically be

applied after 
taking an angle

measurement. If it’s in
the wrong direction,

simply add or delete a
minus sign in front of

the angle value in 
the Options bar.

A single line’s angle is displayed too,
which can be useful for straightening

crooked images.You can measure a line that
should be straight and then use the Image >
Rotate Canvas > Arbitrary command.You don’t
need to enter the value you measured,
because it’s already been entered for you.

4

To measure an angle drag out the
Measure tool along one edge, then [Alt]-

drag from the end point to pull out a second
line.The angle between the two lines is
displayed in degrees in the Option bar and
Info palette.

3

The measurement is given in the
Options bar, and the Info palette, in this

case the line is 280 pixels thick. We can now
make a duplicate line with the same thickness
by entering 280px in the Line tool’s Size field.

2

The Measure tool can be found in the
tenth tool group along with the Eye

Dropper tool.You can use this tool to measure
distances, widths and angles directly in the
image. Here we can measure the exact size of
an object by dragging with the Measure tool.

1



Chapter 10

CREATING 
TOP QUALITY
ARTWORK 

Photoshop has many uses,
ranging from film and

television graphics, to 3D texturing,
to web design, to colour correction
and printing. All are different, yet
Photoshop has the toolset to enable
artists working in totally different
disciplines to get the best results
from their work.

Photoshop is also a superb
photographer’s tool, providing
digital darkroom capabilities that 
are second to none. And with the
proliferation of digital cameras
available these days, the importance
of Photoshop as a photographic tool
has never been greater. What’s more,
the ease of workflow and smart

In this chapter…

S e e  h o w  P h o t o s h o p’s
t o o l s  c a n  b e  u s e d  t o
c o n s t r u c t  a  c o m p l e x ,
m o n t a g e - b a s e d
i l l u s t r a t i o n

L e a r n  t h e  t r i c k s  o f  t h e
t r a d e  t o  c r e a t e  m o r e
p r o f e s s i o n a l - l o o k i n g
a r t w o r k

C o m b i n e  t o o l s  t o  g e t
t h e  b e s t  r e s u l t s  i n  t h e
s h o r t e s t  t i m e

In this final chapter we’ll put together a piece
of artwork using all the tools and options that
we’ve looked at over the course of this
Photoshop Focus Guide

interface makes Photoshop as easy
to use for home dabblers as it is for
the professional artist.

Creating illustrations
Another use for Photoshop is
creating incredible works of art 
and illustrations. These may be
hand-painted, some composite of
photographic or 3D images, or some
wild combination of other media. 
In this last chapter we’ll be putting
together an illustration combining
photos with Photoshop filters,
brushes and effects. We’ll need to
draw on the skills and techniques
learned in the rest of the book in
order to create this image, and you’ll

Zinio
Note
Insert=TrueAlign=Middle



see how the tools used are an
integral part of the creation process,
as well as facilitating the idea itself.

As with any other program, you’ll
need to be aware of the limitations
of Photoshop, or you could end up
painting yourself into a corner.
Often you will need to think ahead
in order to progress smoothly. For
instance, it may be necessary, in
concept, to remove a foreground
element from its background so 
that it can be used in the artwork
seamlessly. However, this can be a
very difficult thing to do – arguably
the single most difficult task a
Photoshop artist can be faced with,
especially if the object in question

has an ill-defined edge. Wispy hair
is a classic case; it can be nearly
impossible to extract this from a
background using Photoshop alone.
Indeed, there are a number of third
party plug-ins designed solely to
tackle this very problem.

Eggs and baskets
Do not make the execution of a
difficult task pivotal in the creation
of an image. It may not work, and 
if it doesn’t, you’ll be left with
nowhere to turn. Photoshop is a 
rich and varied system; explore it
thoroughly and remember any quirks
you discover – you never know 
when you may need to use them.
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Page 115 Seamlessly blend images
over complex backgrounds

Page 113 Create duplicate brush
strokes by stroking a path

Page 119 The illustration is completed
with Vector Shapes and Type elements

Page 110 Selecting and removing a
background is tricky, but worth a try

Page 111 Paint away holes inside a
mask with the Brush tool

Page 112 Reconstruct missing parts 
of an image with the Clone tool



Creating a montage

Now we can experiment with a montage
using all the techniques we’ve learned
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Experimentation
Because this is a
creative exercise, we
can risk experimenting
with cutting out the
background, since 
there may be a 
creative solution 
to any problems 
we encounter.

Background layer
When increasing the
canvas, the
background layer,
which cannot have
transparent pixels, is
filled with the colour in
the background colour
swatch. Set this before
you run the command.

Here’s the resulting selection as a mask.
Not too great, but not bad either. It’s

promising and worth having as a half decent
mask, so let’s keep it and refine it further.

4

Let’s begin by attempting to remove the
background to see how well we can

achieve this.The Magic Wand tool will be first
up to bat. Using the default settings of a 
32-pixel tolerance, we shift-click to select each
sector of the background.

3

We intend to apply as many Photoshop
tools as we can, while attempting to

produce as artistic an image as we can.
Cutting out the background in such an image
can be tricky because of the wisps of hair. We
need to keep this in mind before we commit
to a total removal of the background.

2

Here’s the starting image for our
illustration/montage. It’s a straight

portrait of a model, with even lighting and
good all-round quality. It’s also at a high
resolution of about 3,000 pixels.

1



111ADOBE PHOTOSHOP TOOL TECHNIQUES – FOCUS GUIDE

Artwork project

Invert a selection
We could have

avoided this step by
inverting the selection
before applying it as a
layer mask.To invert a
selection (as opposed

to the pixels within a
selection) type

[Alt]+[Shift]+[I].

Inverted layer
masks

If you want to load a
selection as an inverted
layer mask, you can do

so in one action by
[Alt]-clicking the Add
Layer Mask button in

the Layers palette.
At this point we need to make the
canvas area larger. Using the Image >

Canvas Size command we can expand the
document horizontally to 4,000 pixels.

8

The layer mask can be smoothed to
remove some of the graininess by

applying a filter to it. By applying the Gaussian
Blur filter to the mask (not the image part of
the layer) we can vary the smoothness to get
the right effect.This also has the effect of
fading the edges of the subject, which looks
quite cool.

7

The fixed mask is loaded as a selection
and applied as a layer mask to a

duplicate of the background layer. Another
layer has been added below the new layer and
filled with white.The mask needs to be
inverted, which you can do by selecting it in
the Layers palette and typing [Alt]+[I].

6

In Channel view we can see the mask
and the RGB channels at the same time

by clicking the eye icons next to the channels.
The mask is displayed as a rubylith overlay,
just like in Quick Mask mode.This enables us
to paint out the problem areas with careful
use of the Brush tool.

5



Fix missing parts of the image

We can regenerate our subject with the Clone
tool and add shading with the Burn tool
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Cut and paste
Another approach is
to use selections to
cut and paste sections
of the skin from other
areas of the image.

Safety layer
If you are unsure of
what you are doing,
try cloning onto a
new layer rather than
the image's own layer.
Make sure Use 
All Layers is 
checked, though.

To add back some shading we begin by
adding a bit of highlight to the edge of

the arm to match the existing highlight on the
shoulder. We’ll use a textured brush for this,
and the temptation is to simply paint it on by
hand, which is fine, but there is another way.

4

The tones are a bit blotchy but we can
even them out using the Blur tool.

Remember the tip of reducing the Spacing 
of the brush to increase the strength of the
effect.This won’t fix everything but it’ll help.

3

We use a hard-edged brush for the edge
of the arm to get a good line for her

arm.The inside parts are filled in using a softer
brush.This can be tricky, but don’t worry if it
looks flat – we can add back the shading later.

2

Using the Clone tool we can paint back
part of the model’s left arm, which had

been cropped off in the original image.
Sampling from skin tones nearby the cropped
part of the image we begin to rebuild the
missing portion.

1



Using the Pen as a brush

We can use the Pen tool to create accurate,
repeatable brush strokes
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Sketchy stroke
The technique of
using a pen as a

stroke can be applied
in other ways.You can

give vector shapes 
a more 'hand-drawn'

look by stroking them
with sketchy brushes.

Broken paths
Break up a complex

path into different
sections to add 

variety and detail to
stroked paths.

The rest of the arm is touched up to
remove any further unevenness in tones

on the skin (the eye is very sensitive to this)
using the Burn and Clone tools.The result is
pretty good, especially if you didn’t know
where to look for the fix-up job.

4

By repeating this action with
successively smaller radius brushes we

can create a nice fake illumination to the edge
of the arm. Each stroke passes in exactly the
same position because of the path.

3

We select the Dodge tool and set up a
large textured brush for it in Midtones

mode at 50% strength. By clicking the Stroke
Path with Brush button selected in the Paths
palette, the Dodge tool will be stroked along
the path.

2

In order to have a bit more precision
when adding the highlight, we can use

the Pen tool. We begin by drawing a path
along the length of the arm.

1



Using the Pen as a brush continued
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Keep it real
Overdo a touch-up
job and your subject
can end up looking
like one of those
plastic models on the
front of countless
fashion mags.
Remember to keep
your effects subtle.

Progress report
Use the Zoom tool to
zoom out of the
image to look at the
image as a whole.
This will give you a
good idea of how well
the touch-up is
coming along.

You can be as thorough or as subtle as
you like when using the Healing tool.

In this example we’ve removed the small
wrinkles near the corners of the eye.The right
side has been done and the left side has not.

8

Next we can tackle the occasional
blemish.The odd spot is removed using

the same technique with the Healing Brush
tool. Note that even where there are areas of
high contrast and detail (such as where the
light strikes her face at the edges) the tool will
still work well.

7

The most obvious lines to fix are those
on the brow. Using a brush that’s about

three times the width of the line, we take a
sample just above it and paint it out.You must
be careful not to overdo it and remove all the
lines totally, as it can look too false.

6

The next tool we need to use is the
wonderful Healing Brush.We can use

this to just subtly remove some wrinkles and
blemishes from the model’s face.

5



Adding a background

We can add a colourful background in order to
provide more visual impact
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Discard or apply?
When you discard a

mask by dragging it to
the trash, you are

prompted to discard or
apply the mask.

Choosing the option to
Apply cuts away the

masked pixels before
the mask is deleted.

Trash layers
Any layer element can

be deleted by dragging
it to the trash can icon

at the bottom 
of the palette.

Next we load the layer mask as a
selection, and then use the Selection >

Feather command and a large value (about
60) to smooth the selection.Then we shrink it
by 20 pixels using the Selection > Modify >
Shrink command.

4

We decide to go with a creative effect to
solve this problem – blurring them until

they are unnoticeable. Before we do that we
remove as much of the white as possible using
an eraser.The layer is duplicated and the mask
is applied to the layer by dragging it over to
the trash beforehand.

3

The render is dragged into the main
Photoshop illustration document by

dragging its layer from the Layers palette and
dropping it over the image. Placed below the
masked layer we can see the edges of the
original background more clearly.

2

The white background was just a 
stand-in to enable us to see the effect of

the layer mask. We can replace it with a better
image, such as this.This is not a photo or a
painting, but a 3D render produced using
some special focus rendering effect.

1



Adding a backgroundcontinued
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More layers
Always think how
something can be
accomplished without
actually changing any
pixels destructively.
Rather than adjusting
the colours of the girl
layer directly we use
another layer in Colour
blending mode.

Overwrite rules
You will find that
some work you do
earlier will be negated
by later artistic
changes. Don't worry
- it's a part of the
process that even best
laid plans can't avoid.

The Opacity is adjusted to get the right
blend.Too much and the girl’s colours

are washed away; too little and she stands out
too much.The greenish/yellow patch of the
red layer is removed by cloning over it.

8

To blend the colours of the background
and the girl better we can make use of

Photoshop’s blending modes.The red
background layer is duplicated, blurred and
placed above the girl layer. Using Colour
mode, the layer’s colours are transferred to the
girl layer.

7

We can make use of this same selection
again by applying it as a layer mask to

the blurred girl layer and inverting it.This
fades out the blurred portion, blending it into
the background. Levels are used to adjust the
degree of blending.

6

The selection is inverted using
[Alt]+[Shift]+[I] so that only the outer

edges will be affected; the face will stay sharp.
Gaussian Blur is used to blur the edges of the
girl, producing a forced ‘depth of focus’ effect
and hiding a lot of the white edge.

5
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Advanced
blending

Access a layer’s
options panel by

double-clicking it.
Here you can find the

advanced blending
sliders. In this case, the
‘This Layer’ slider is set

to Red and the dark
slider moved towards

the right to fade out
those colours only.

Split the sliders
To ‘split’ the sliders you 

[Alt]+drag them.This
has the effect of

feathering the
transparency of the
layer to prevent an

obvious cut-off point
for the blend.

A mask is added to remove the sparks
that cover the girl’s eyes and face.This 

is painted on using a large soft brush, varying
the opacity as we go, by making use of the
numeric key pad.

12

The sharp red layer is once again
duplicated and moved to the top. We

want some of the sparks to be in front, as well
as behind, to give some more depth to the
image.The Layer is applied in Screen mode
but most of the flat red colour is removed
using the sliders in its layer options.

11

In fact, the opposite works well too:
applying the duplicated layer in Linear

Dodge mode brightens the girl up, but
likewise it also intensifies the image – it’s time
to make a decision.

10

To intensify the girl layer and add more
contrast to it once more, Layer Blending

modes come to the rescue. The girl layer is
duplicated and applied in Linear Burn mode,
with an opacity of 50%.

9



Applying artistic detail

We can use the Art History Brush here to add
some extra background detail
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All about image
Because the Art History
Brush applies new
pixels using original
colour, you can make
low-res images into
high-res ones.

Effect limitations
Very small images
blown up very large will
start to show pixels and
compression artefacts,
so the effect has 
its limits.

A very fine brush is finally applied to
pick out the fine edges.You only need

to do this where needed, because it can be
quite slow.The layer is applied in Hard Light
mode and a Gradient Layer Mask fades out
the left side.The other elements are
repositioned for better composition.

4

Using successively smaller brushes 
and changing to the Tight Medium 

Art mode, we can add back some detail.The
brushes we used were 200, 100, and then 50
pixels in radius.

3

To get round this we can apply the Art
History Brush to ‘regenerate’ the pixels

in the enlarged layer. We mark a previous state
as the source for the Art History Brush and
begin filling in the canvas with a large brush in
Dab mode.

2

A selection is made of the girl’s eyes 
and copied to a new layer.This layer is

enlarged to fill the document. However, when
you do this, the image quality will suffer.

1



Vector Shape and Type layers

We can add further creative elements using
Vector Shape and Type layers
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Artwork project

Balancing elements
When creating an

image such as this, try
to balance the

foreground and
background elements,

making sure the
background detail does
not overpower or clash
with the main subject.

Big impression
Using a Hue/Saturation

Adjustment Layer you
can change the feel of

the entire image just by
changing some 

of the colours.

Finally, a layer mask is applied to the
Levels Adjustment Layer. Using the

Gradient tool set to black and white and
Radial mode, a gradient is drawn that protects
the girl’s face from the effect of levels.

4

A Levels Adjustment layer is applied to
the image and a Vector Shape is used as

a mask to create a further layer of detail in the
image. A combination of two overlapping
Vector Shapes in Exclude mode interacts to
create an interesting shape.

3

The Warp Text tool helps to bend the 
7 into a more interesting shape, and

assists in integrating it into the image depth-
wise. A layer mask aids this further making it
appear to wrap around the girl. Applied in
Screen mode, an Outer Glow Layer Style
makes for a subtle effect.

2

A Type layer is added by clicking on the
image with the Type tool. Appropriately,

the number 7 will be used as a graphic
element for the image, since 7 is the current
version of Photoshop.

1



On your CD-ROM/DVD

To access the programs and files
on this disc, including the

photo collection from Image Source,
first insert the disc into your drive.
Whether you’re using a PC or an
Apple Mac, the disc will work
equally well. If it doesn’t run
automatically, look at the opposite
page to find out how to start your
installation manually.

Before you go on
The first item that should appear 
on your screen is the disclaimer
window; here you’ll need to click 

Featured software…

V i d e o  t u t o r i a l s  t o  t a ke
y o u  t h r o u g h  t h e  t o o l s

E v e r y  P h o t o s h o p
h o t ke y  f o r  P C  a n d  M a c

on ‘I Accept’. Please remember that
this disc has been thoroughly
scanned and tested at all stages of
production, but – as with all new
software – we still recommend that
you run a virus checker before use.
We also recommend that you have
an up-to-date backup of your hard
disk before using this disc. Future
Publishing does not accept
responsibility for any disruption,
damage and/or loss to your data or
computer system that may occur
while using this disc, or the data and
programs on it. Please consult your

Here’s how to get the most from the disc 
that accompanies your Focus Guide

As well as the printed tutorials in this issue, George Cairns

has supplied a range of video tutorials covering a wide

variety of the tools available to Photoshop users. George will

take you through the basics of each tool, what they are

called, what they do, where they can be found as well as a

brief description of how to use them.

Watch and learn about the following essential tools: Blur tool,Brush

tool,Crop tool,Dodge and Burn tool,Erase tool,Eye Dropper tool,

Gradient tool,Hand tool,Healing tool,History Brush tool,Lassoo

tool,Magic Wand tool,Move tool,Note tool and Slice tool.

VIDEO TUTORIALS

The toolbar explained by Photoshop expert George Cairns

Photoshop expert George Cairns takes
you through the tools of the trade in
our superb video tutorials



network administrator before
attempting to install any software 
on a networked PC.

Installation
Once inside you’ll find yourself 
on our introduction screen, with a
number of options in the menu bar
along the top. Click on the relevant
link in the menu bar to access the
file or program that you require. 
If you have a query about your disc’s
interface or content, email our support
team (support@futurenet.co.uk) for
help. If you want to talk to a member

of the team, call 01225 822743.
Please note that we can only provide
basic advice on using the interface
and installing the software. We
cannot give in-depth help on
specific applications, or on your
computer’s particular hardware 
or operating system.

121ADOBE PHOTOSHOP TOOL TECHNIQUES – FOCUS GUIDE

On your CD-ROM/DVD

Finding 
your files

Click on the Focus Guide link

at the top of the disc

interface screen to 

access all the files that

accompany this book.

The PDF documents on your disc, provided by GFX^TM,

contain every Photoshop 7.0 hotkey for both PC and Mac.

A hotkey is simply a keyboard shortcut that saves you

having to click through on-screen menus with your mouse.

While you may know that pressing [Ctrl]+[C] on your

keyboard is how you would copy a selection, for example,

you may not know that 'Fill from History and Preserve

Transparency' can be accessed by [Ctrl]+[Alt]+[Shift]+

[Backspace].These indispensable documents catalogue over

250 keyboard shortcuts and are a useful resource for

Photoshop beginners and experienced users alike.

PHOTOSHOP HOTKEYS

Over 250 keyboard shortcuts for just about any Photoshop task

There’s a wealth of Photoshop training
material and experience on the GFX^TM
website: www.user.fundy.net/morris

http://user.fundy.net/morris

http://www.user.fundy.net/morris
http://user.fundy.net/morris
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Glossary

Finding the lingo a puzzle? Here’s your handy
guide to essential terms found in this Focus Guide

Alpha channel
Alpha channels are stored
alongside colour channels
within Photoshop files but do
not affect the final image
printout. Instead, they store
information that is helpful to
you, such as saved Masks.

Anti-aliasing
Moving pixels around can cause
undesirable jagged edges to
appear, where edited pixels have
not blended smoothly together.
Anti- aliasing refers to the process
of smoothing out these jagged
edges for a more natural look. 

Brush
Brushes enable you to paint on
Photoshop images with colour,
other bits of images and pre-
defined patterns. They mimic
real brushes in that you can
alter the size, hardness and
texture in order to achieve the
effects you want.

Colour channel
There are three colour channels
in all colour images: red, green
and blue. Each one contains
information specific to that
colour. Photoshop enables you
to alter each channel
independently, making it
possible to reduce grainy blue
skies without affecting the rest
of an image, for example.

Feathering
Softening the edges of pixels in a
selection, so that they will blend
smoothly when moved elsewhere.
Photoshop does this by only
partially selecting some of the  pixels
around the edge of the selection. 

Filter
One of Photoshop’s preset tools
that applies an effect to an
image (or a selection within the
image). Examples include
sharpening, blurring, creative

and artistic filters. You’ll find 
a complete list by clicking in 
the Filter menu at the top of 
the Photoshop window.

Font
A commonly used term used to
describe the typeface you are
using. For instance, Times New
Roman is a font where all the
letters look fairly formal. In
Arial, however, all the letters
are far simpler looking.

GIF (or .gif)
A type of image file format best
suited for producing simple
images for the web. Examples
include logos, banners, buttons
and anything made up of only a
few flat colours.

Greyscale
An image is greyscale if it
contains no colour information.
Almost all digital camera files,
for instance, will be in colour.
But you can turn them into
black and white with many fine
gradations of grey, from within
Photoshop by turning them in to
greyscale images.

Image size
This refers to the physical size
of an image. For instance, a
photograph you are working on
may be 20x15cm. This matters
most when you come 
to printing out the image.

JPG (or .jpeg)
A type of image file format that
gives a desirable combination of
small file sizes and good quality
photo reproduction. It is
commonly used in digital
cameras to store the images that
you take. The small files sizes
also make it ideal for the web.

Layer
Layers containing effects or bits
of images can be stacked on top

of the original image layer (the
background) in order to change
the appearance of the image.
Layers do not directly affect the
layers beneath them, in the
same way as a blurry piece of
glass placed over a photograph
does not actually affect the
photograph – in both cases, it is
the appearance that is changed,
leaving the original untouched.

Marquee
The flashing dotted outline that
surrounds a selection. You’ll
also see it referred to in some
places as ‘marching ants’.

Navigator
In Photoshop’s default screen
layout, the Navigator is
positioned in the top-right
corner and gives you access to
the whole image, even if you are
currently zoomed in to a
specific part. The red box within
the Navigator image denotes the
area that is currently on screen;
you can move around your
image by clicking and dragging
the red box around the
Navigator image.

Resolution
A measure of how many pixels
make up an image. A resolution
of 300dpi (dots per inch) is
recognised as the minimum 
if you’re intending to print 
your images.

Selection
Any part of an image which you
select with Photoshop’s tools,
shown by a marquee around it.
You can then work on certain
parts of an image, or remove
then without affecting the rest.

Slices
These are special kinds of
selections for web page design. An
image can be split into segments or
slices, and Photoshop creates an

HTML file, plus separate image
files, for each slice. The web
browser then reassembles the slices
in their original position to give the
appearance of a single image.

Thumbnail 
A small, ‘thumbnail-sized’
version of an image. You’ll find
them in folders of images and 
in Photoshop’s File Browser –
Because they’re smaller than a
full size image you can browse
through them more quickly,
which makes finding the file
you’re after far easier.

Pixel
An abbreviation for ‘picture
element’, it is essentially a tiny
dot of colour on screen. Most
images are made of up millions
of pixels, which combine to
make an image look seamless.
Zoom in very close on an image,
however, and you can clearly
see these individual pixels.

PSD
Photoshop’s own file format,
which preserves things such as
layers and channels. If you’re
editing an image file, it’s
sensible to save it as a PSD, in
order for the changes you have
made to remain editable when
you next open it.

Tool Options bar
When a tool is selected, the
corresponding Tool Options bar
automatically appears at the top
of the Photoshop window,
giving you access to various
options, including such things
as Brush Sizes and Feathering.
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